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Oracle AS SPI Concepts

The HP Operations Smart Plug-in for Oracle Application Server (Oracle AS SPI) enables you
to manage Oracle Application Servers from an HP Operations Manager for UNIX (HPOM)
console. The Oracle AS SPI adds monitoring capabilities otherwise unavailable to HPOM. For
more information on HPOM, see HP Operations Manager for UNIX Concepts Guide.

Introducing the Oracle AS SPI

The Oracle AS SPI, used in conjunction with HPOM, offers centralized applications that help
you monitor and manage systems using Oracle Application Server. From the HPOM console,
you can monitor the availability, use, and performance of Oracle Application Servers running
on HPOM managed nodes. You can set threshold values for the Oracle AS SPI metrics. When
these thresholds are crossed the Oracle AS SPI generates an alarm and message. The metrics
can also be consolidated into reports and graphs that help you analyze trends in server usage,
availability, and performance. You can integrate the Oracle AS SPI with HP Reporter and HP
Performance Manager to get additional reporting and graphing flexibility and capabilities.
For details on integrating the Oracle AS SPI with other HP products, see Chapter 5,
Integrating HPOM Reporting and Graphing Products with the Oracle AS SPI.

Smart Plug-in Data

The Oracle AS SPI has several server-related metrics that gather data about the following:
e Server availability

e Server performance

e JVM memory usage

e EJB client and method wrapper active threads, execution times, and calls processed

e Servlet execution times and threads

e JSP service time and active requests

e Java message service connections and messages

e JDBC connection status

e  Web application processing and open sessions

e HTTP server active connections and processed data
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Smart Plug-in Uses and Customizations

As an Oracle AS SPI administrator, you can choose the metrics most crucial for the operation
of Oracle Application Server by modifying the Oracle AS SPI policies. These policies contain
settings that enable incoming data to be measured against predefined rules. These rules
generate useful information in the form of messages. These message have color-coding to
indicate the severity level. You can review these messages for problem analysis and
resolution. There are several pre-defined corrective actions for specific events or threshold
violations. These corrective actions can be automatically triggered or operator-initiated. When
you double-click a message, corrective actions appear under the Instructions tab and
automatically generated metric reports appear under the Annotations tab in the Message
Properties window.

Functions of the Oracle AS SPI

The Oracle AS SPI messaging, reporting, and action-executing capabilities are based on the
HPOM concept of policies. For more information, see HP Operations Manager for UNIX
Concepts Guide. The settings within these policies define various conditions that can occur
within the Oracle Application Server and enable information to be sent back to the HPOM
management server. This helps you to proactively address potential or existing problems and
avoid serious disruptions to web transaction processing. The Oracle AS SPI performs the
following functions described in the following sections:

Collecting and Interpreting Server Performance and Availability Information

After you configure the Oracle AS SPI, and the policies are deployed to the managed nodes,
the SPI starts gathering server performance and availability data. This data is compared with
the settings within the deployed policies. The policies define conditions that can occur within
the Oracle AS Server, such as queue throughput rates, cache use percentages, timeout rates,
and average transaction times. The policies monitor these conditions against default
thresholds (set within the policies) and trigger messages when a threshold has been exceeded.

Displaying Information

The Oracle AS SPI policies generate messages when a threshold is exceeded. These messages
can appear as:

Messages in the Message Browser — HP Operations agent software compares the values
gathered for Oracle AS Server performance and availability against the monitor policy
settings related to those specific areas. The agent software then forwards appropriate
messages to the HPOM console. These messages appear with color-coded severity levels in the
HPOM message browser. To view the Message Browser, select Integrations — HPOM for UNIX
Operational Ul from the Administration UL
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Figure1l Message Browser
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Instruction Text — Messages generated by the Oracle AS SPI programs contain instruction
text to help analyze and solve problems. You can manually perform corrective actions
preassigned to events or they can be triggered automatically. Instruction text is present in the
Message Properties window. Double click the Message Text, the Message Properties window
opens. To view instruction text, click the Instruction tab. Instruction text is also available in
the HP Operations Smart Plug-in for Oracle Application Server Reference Guide.

Figure 2 Instruction Text

Mes=zage Properties

_\, Severity: Warning  Message Text: Can't add node to IP address mapping takb...
m Mes=age Text Original Message m‘ Instructions Ig_‘IL

---- QpiZ20-5302
The node name cannat be resolved by the name service. For HPOM to work
correctly, it iz important that the nodes are resolvable by the name service.
Please check, if there is a problem with the name service.

If the node was renamed, please modify the node swithin HPOM, Please follow
the procedure in the Admin Reference Guide.

If the name service was temporarily unavailshle, this error can ke ignored.

ASCII-Text Reports - In addition to the instruction text, some messages cause automatic
action reports to be generated. These reports display conditions of a specific Oracle OC4d/
OHS server instance. If a report is available, you can view it by clicking the Annotations tab in
the Message Properties window.

Oracle AS SPI Concepts 13



Figure 3 ASCII-Text Reports

Mes=age Properties

@ Severity: Critical  Message Text Error: btowmd 30 parent! .com' - Sign...

Annotation: of 1

author: | Opc |

Drate.Time: | Debfl 5400 1 505 43 |

Performed Message Correlation »
Add Hew Annotation

Mes=sage Key Relation : Certificate-bZ3al?8ciZ-4eea-7E5325-000£-hk
dffldbaeble-0pC40-Z0[05 |LO[1LI1Z211E5 1161733616263 1621651
EF7E|7E]

This message automatically acknowledged the following messag

=z
bfgdEEPd-E0c2-F1lde-1E4c-0£2a81£20000

|:| Dizakle Autoscroll

Generating Reports Using HP Reporter

You can integrate the Oracle AS SPI with HP Reporter to provide you with
management-ready, web-based reports. The Oracle AS SPI Report package includes the
policies for generating these reports. You can install the Report package on the Reporter
Windows system.

After you install the product and complete basic configuration, Reporter generates reports of
summarized, consolidated data every night. With the help of these reports you can assess how
the Oracle OC4J/OHS server is performing over a period of time.

Graphing Data with HP Performance Manager

Metrics collected by the Oracle AS SPI can be graphed. The values can then be viewed for
trend analysis.

You can integrate the Oracle AS SPI with HP Performance Manager to generate and view
graphs (use the View Graphs tool from the OASSPI Admin tools group to view graphs). These
graphs display the values of the metrics collected by the Oracle AS SPI. You can click Perform
Action to view graphed data from almost all the Oracle AS SPI alarm messages. Perform Action
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is present within the Actions tab in the Message Properties window. The action launches your
web browser, where you can choose a graph that displays values for the metric which
generated the message as well as other related metrics

Customizing Policies and Metrics

You can use the Oracle AS SPI policies without customization, or you can modify them to suit
the needs of your environment. Some of the modifications and customizations that you can do
are the following:

e Modify the default policies— Within a policy, you can change the default settings for:
— Collection interval
— Threshold
— Message text
— Duration
— Severity level of the condition
— Actions assigned to the condition (operator-initiated or automatic)

e Create custom policy groups— You can create custom policy groups, using default policies
as base. For more information, see Chapter 4, Customizing the Oracle AS SPI Policies.

¢ Create custom metrics— You can define your own metrics or User Defined Metrics (UDMs)
to expand the monitoring capabilities of the Oracle AS SPI. For more information about
UDMs see the HP Operations Smart Plug-in User Defined Metrics User Guide.

Components of the Oracle AS SPI

The Oracle AS SPI has two main components:
e Tools (including reports)
e Policies

You can use the tools and policies to configure and receive data in the form of messages,
annotations, and metric reports. These messages (available in the message browser),
annotations (available through message properties), and metric reports (available through
tools) provide information about the conditions present in the servers running on specific
managed nodes.

The Oracle AS SPI configuration tools let you configure the management server’s connection
to selected server instances on specific managed nodes. After you configure the connection,
you can assign policies to the nodes. With HP Operations agent software running on the
managed nodes, you can use the Oracle AS SPI reporting tools to generate metric reports. In
addition, you can generate graphs which show the Oracle AS SPI data (available through
message properties).

Tools

The Oracle AS SPI tools include configuration, troubleshooting, and report-generating
utilities.

Oracle AS SPI Concepts 15



76

The Oracle AS SPI version 6.10 uses JMX standards to discover and monitor Oracle
Application Server 10gR3. The metrics, policies, and reports for Oracle AS, therefore, are now
divided in two groups. For example, the OASSPI Reports is divided into OASSPI Reports

group and OASSPI Reports (JMX) group. These groups are explained in detail in the following
sections.

e OASSPI Admin Tools Group

e Oracle AS SPI Tools Group

e (OASSPI Reports Group

e OASSPI Reports (JMX) Group

e JMX Metric Builder Tools: This tool group is available only if you install the SPIJMB
software.

Figure 4 Elements in Tool Group “SPI for Oracle AS”

Elements in Tool Group "SPI for Oracle AS"= - o -
Tool Bank / OASSPI:TOOLS
Administrative and Operator Tools for the SPI for Oracle Application Server.

Details 5Pl for Oracle A5 -  Filter =

Found 4 Elements

B Type Label Hame + Contents Description

D " Oracle AS SPI DASSPLADMIN h~ O~ 0/5s QASSPI SPI Admin tool group

D o OASSPI Reports OASSPLREPORTS Ch O~ 0/19 Azcii metric reports for Oracle Application Server

D " OASSP| Reports (JMX) QOASSPLREPORTS JMX Ch O~ 0/18 Aszcii metric reports for Oracle Application Server (JMX)
[0 ™ OASSPIAdmin OASSPLSPI ADMIN Che O~ 0/10 OASSPI SP1 Admin tool group

L|Chuuse an action v|a

OASSPI Admin Tools Group

OASSPI Admin tools enable you to configure, control, and troubleshoot the Oracle AS SPI.
You require root user permission to run OASSPI Admin tools.
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Figure 5 OASSPI Admin Tool Group

Elements in Tool Group "OASSPI| Admin" = - o -
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Found 10 Elements
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D " Self-Healing Info OASSPIDERUG h ~ 3 ~ Gather Data Needed For Support

D " Discover or Configure OASSPIDISCOVER OR CONFIGURE [H ~ 43 + Dizcover the Application gerver or Configure g
O " %ﬁﬂuut DASSPLINT NON-ROOT h~ O~ ::':r:[l?:c:ll-ﬂunt

D " Start Monitoring OASSPLSTART MONMTORING h ~ 3 - Start Oracle Application Server SPI monitoring
D " Stop Monitoring OASSPLSTOP MONMTORING [h = 43 -~ Stop Oracle Application Server SPI menitoring
|:| “i» Stop Tracing OASSPITRACE OFF [h~ # -~ StopTracing

|:| “ip Start Tracing OASSPITRACE ON [h ~ & -~ StartTracing

Fl " Werify DASSPIVERIFY INSTALLATION h~ & ~ Verify OASSPI Installation

D “ip View Error Log OASSPIVIEW ERROR FILE h~ & ~ View OASSPlInternal Log

D " View Graphs OASSPIVIEW GRAPHS [~ 3 + OASSPIGraph gelection and viewing

T_ | Choose an action - | [ |

The tool group contains the following tools:

Discover or Configure OASSPI- Launches the configuration editor and maintains the
Oracle AS SPI configuration or sets basic configuration properties needed for discovery.

Init Non-Root— Simplifies the configuration of a non-root HT'TPS agent on a UNIX
managed node. For all the steps necessary to configure a non-root HTTPS agent on a
UNIX managed node, see Configuring a Non-Root HTTPS Agent on a UNIX Managed
Node on page 45.

Self-Healing Info— Collects data to be sent to your HP Support representative.

Start Monitoring— Starts the collection of metrics for one or more OC4J/OHS servers on
a managed node.

Launch the Verify tool to determine if monitoring is started or stopped. By default,
monitoring is on.

Stop Monitoring— Stops the collection of metrics for one or more OC4J/OHS servers on a
managed node.

Start Tracing— Starts logging the information about each of the activities performed by
the SPI into a file. Run this tool only when instructed by your HP support representative.

Stop Tracing- Stops saving the information about each of the activities performed by the
SPI into a file. Run this tool only when instructed by your HP support representative.

Verify- Verifies that the files required for the functioning of the Oracle AS SPI
(instrumentation, configuration, library files, and so on) are properly deployed.

View Error Log- Enables you to view the contents of the Oracle AS SPI error log file
(wasspi perl.log).

View Graphs— Enables you to view the Oracle AS SPI graphs, generated by HP
Performance Manager, in a web browser.
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For more information about each of the above tools, see Appendix C, Tools.

Oracle AS SPI Tools Group

You can manage the Oracle Application Server functions by using the tools in the Oracle AS
SPI tools group.

To access the tools in the Oracle AS SPI group click OASSPI:TOOLS - OASSPI:ADMIN in the
Tool Bank window.

Figure 6 Oracle AS SPI Tools Group

Elements in Tool Group "Oracle AS SPI"=~ o ~
Tool Bank / CASSPI:TOOLS / OASSPLADMIN
QASSPI SPI Admin tool group

Details Oracle AS 5Pl »  Filter «
Found 5 Elements

B Type Label Hame + Description

D " View Oracle AS Status OASSPLCHECK OAS STATUS h~ 4 « View =tate of Oracle Application Server
D "o Start Oracle AS OASSPLSTART OAS h - {3 ~ Start Oracle Application Server

D "o Launch Cracle AS Console OASSPLSTART 0AS CONSOLE h + 4 » Launch Cracle Application Server Conzole
O "o Stop Oracle AS OASSPISTOP DAS h~ 4 -~ Stop Oracle Application Server.

D "I View Oracle AS Logs OASSPIVIEW 0AS LOG h~ 4 ~ View Oracle Application Server Log Files
T_|Chc|use an action v|a

The Oracle AS SPI tools group contains the following tools:

e Launch Oracle AS Console- Launches the Oracle Application Server Control Console,
launch the AggreSPY servlet, or the Oracle Enterprise Manager Database Control
(requires setup).

e Start Oracle AS- Enables you to start the Oracle Application Server (requires setup).
e Stop Oracle AS- Enables you to stop the Oracle Application Server (requires setup).
e View OAS Logs— Enables you to view the Oracle Application Server log files.

e View Status— Does an interactive status check of the Oracle Application Server.

OASSPI Reports Group

OASSPI Reports group contains reports that show information about the condition of the
Oracle Application Server.
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Figure 7 OASSPI Reports

Tool Bank / OASSPLTOOLS / OASSPI:REPORTS
Ascii metric reports for Oracle Application Server
Details OASSPI Reports w  Filter -
Found 1% Elements
B Type Label Hame Description
IF " C005 JVMMemUtiPct QASSPLOASSPI 0005 h + & = Percentofheap space used in the JVM
D " C010 CPUULIPct OASSPLOASSPI 0010 h + 4 = Percent ofthe CPU time utilized over the collection interval
D " C011 MemoryUtiPct 0ASSPLOASSPI 0011 h + £ - Percent ofthe physical memory utilized over the collection interval
D " CO050 JMSConnCreated OASSPLOASSPI 0050 h ~ £ - Frequency of the JMS connections created over the collection interval
D % C100 HTTPSwrActConn 0ASSPLOASSPI 0100 h » £ -~ Number of active HTTP connections
D %t 220 EJBClACtThresds OASSPLOASSPI 0220 h = 4 -~ Current number of threads accessing the actual implementation of the method
D "t (C221 EJBClAvgExecTim OASSPLOASSPI 0221 h = £ - Average time spent inzside the actual implementation of the method
O " C222 EJBCICallsPrcRt QASSPLOASSP 0222 h ~ & ~ Mumber of requests processed by the actual implementation of the method over the collection interval
[] "o C230 EJBWrapAciThros — OASSPLOASSPI 0230 [ v {3 + Curent number of threads accessing the auto-generated wrapper method
D " C231 EJBWrpAvEXecTim OASSPLOASSPI 0231 h + 4 -« Average time spent inside the auto-generated wrapper method
D " C232 EJBWrpCallPrcRt OASSPLOASSPI 0232 h + £ - Total number of requests processed by all auto-generated wrapper methods over the collection interval
D % C240 SrvitAvgExecTim OASSPLOASSPI 0240 h ~ £ - Average time spent on the serviet's service() call (in meece) over the collection interval
D % C242 SrvitActThreads OASSPLOASSPI 0242 h » £ -~ Current number of threads servicing the serviet
D % C245 JSPAvoExecTime OASSPLOASSPI 0245 h » £ -~ Average time to 2erve a JSP (in meecs) over the collection interval
D “it» 247 JSPActRequests OASSPLOASSPI 0247 h =~ £ - Current number of active requests for the JSP
O " C251 JMSTotalMsqCt QASSPLOASSPl 0251 h ~ & -~ Total number of ges contained in the ge store
IF " C260 JDBCacheMissPct DASSPLOASSPl 0260 h + 4 = Generate autoaction report for C260_JDBCacheMissPct
D " C280 WebCnbxttwRgPre OASSPLOASSPI 0280 h + £ « Average time spent servicing web requests (in msecs) per request processed, over the collection interval
D “p C281 WebCntuthctSess 0ASSPLOASSPI 0281 h + £ - Current number of active sessions
4 [ choosean acton bl |

To generate a report, select Integrations — HPOM for Unix Operational Ul. Right-click the
managed node and select Start = SPI for Oracle AS > OASSPI Reports > <Name of the Metric
Report>. Each report reflects shows the condition of all configured server instances on the

managed node in relation to the metric for which the report is generated.

An alarm condition can generate a report. These reports are generated automatically and are
context sensitive, relating only to a single server on the managed node. These reports appear
within the Annotations section of a message.

If you configure the message browser to display the SULIAONE columns, a flag appears under
the S column (adjacent to the message) when a report is generated.

OASSPI Reports (JMX) Group

Oracle AS SPI Concepts

The Oracle AS SPI Reports (JMX) group contains ASCII metric reports that display
information about the condition of the Oracle Application Server 10gR3 using JMX standards.
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Figure 8 OASSPI Reports (JMX) Group

Tool Bank / DASSPI:TOOLS / OASSPEREPORTS_JMX

Ascii metric reports for Oracle Application Server (JMX)

Details OAS5PI Reports (JMX) w  Filier »

Found 18 Elements

B Type Label Name

D " CO005 JVMMemUtiPct DASSPILMX):0ASSPI 0005
|:| " CO012 CPUULIPCIHTTP DASSPILMX).0ASSP 0012
|:| " [243 ServietRegRate OASSPILJMX).OASSPl 0243
|:| " C245 JSPAvgExecTime OASSPIJMX).OASSP 0245
|:| “ip [248 JSPRegRate OASSPILJMX).OASSP| 0245
[l "t J272 TranRollbackResourcert DASSPILJMX):0ASSP 0272
O " J340 SrvitAvgExecTim OASSPILMX):.0ASSP| 0340
O " J352 JMSPendingMsgs OASSPILJMKX).OASSP 0352
D " 1353 JMSWsgExpired DASSPILMX):0ASSP 0353
D " J380 JDBCConnPoolUtil OASSPILMX):0ASSP| 0350
D " J362 JDBCCNPIAMCNtSm DASSPILMX):0ASSPl 0362
D " J383 JOBCAvgUseTim DASSPILMX).0ASSP 0363
|:| "  J384 JDBCAvVGWWaITim DASSPILMX).0ASSP 0364
|:| " J385 JCAConnPoolUtil OASSPIJMX).OASSP 0365
|:| " J367 JCACNPIWCNtSm OASSPILJMX).OASSPI 0367
|:| " J388 JCAAvgUseTim OASSPIJMX).OASSP 0368
O " J389 JCAAvgWaitTim OASSPILJMX).OASSP 0365
O " J371 TranRollbackRt OASSPIJMKX).OASSP 0371
L|Chuuse an action v|m

=
=
=
=
[
=
[
[
[=
[
=
=
=
=
[
=
[
=

Description
Percent of the heap space used in the JWM

Percent of the CPU time utilized over the collection interval by HTTP_Server

Number of requests for a servlet per second

Average time to serve a JSP (in meecs) over the collection interval

Number of requests for a jsp per second

Number of transactions relledback due to and error in an enlisted rezource per second
Average rezponse time of a serviet (in meecs) over the collection interval

The total number of pending messages over the collection interval

The total number of mezzages that have expired over the collection interval
Percentage utilization of available JDBC connections in connection pool

The total number of threads waiting for a connection

Average time =pend using a connection (in meecs) over the collection interval
Average time spend waiting for a connection (in msecs) over the collection interval
Percentage utilization of available JDBC connections in connection pool

The total number of threads waiting for a connection

Average time spend using a connection (in meecs) over the collection interval
Average time spend waiting for a connection (in meecs) over the collection interval

Number of transactions relledback per second

JMX Metric Builder Tools

The JMX Metric Builder Tools group contains the following tools:

e Deploy UDM- Deploys the UDM file.

e Gather MBean Data—Collects MBean information that is used with the JMX Metric

Builder.

e JMX Metric Builder— Launches the JMX Metric Builder tool that is used to create

UDMs and browse MBeans.

e  UDM Graph Enable/Disable— Starts/stops data collection for UDM graphs. Also starts/

stops the HP Operations subagent.

For more information about the JMX Metric Builder Tools group and steps to install the
SPIJMB software, see the HP Operations Smart Plug-in for User Defined Metrics User Guide.

Oracle AS SPI Policy Groups and Policies

In the Policy bank window, the SPI for Oracle AS policy group contains policies grouped into

two policy groups:
e OASSPI
e OASSPI Discovery
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Figure 9 Elements in Policy Group “SPI for Oracle AS”

Policy Bank / SPI for Oracle AS

[5P| for Oracle AS GROUP

Details 5P for Oracle AS +  Filter =

Found 2 Elements

Ml Type Name T Assigned Latest Mode Smart Plug-in Categories Contents Description

O o DASSPI h- O~ 511 DASSPI GROUP

D " OASSPI Discovel G O~ 02 OASSPI Discovery GROUP
t | Choose an action v|

The OASSPI policy group contains the following policy sub-groups and policies:
Figure 10 OASSPI Policy Group

Flements in Policy Group "SPI for Oracle AS/OASSPI" = - o -

Policy Bank / SP| for Oracle AS / OASSPI

DASSPI GROUP

Details DAS5PI w  Filter w

Found § Elements

H Type Name T Assigned Latest Mode Smart Plug-in Categories Contents
|:| o DASSPLLogfiles S O~ 0/5

F o QASSPLMetrics S O~ 0720

] “ QASSPEMetricalIMX] Ch O~ 0T
1 " OASSPLMeniters - O~ 07

D o OASSPEMeniterslJMX] B O~ 0/3

D & OASSPLMeszages 7o 7o Fixed h O~ CASSP| Dizcovery

t | Choose an action ' | a

OASSPI-Logfiles — Contains policies that generate messages based on log file and error
text detected in both the Oracle Application Server log files and the Oracle AS SPI log
files. The information captured from these log files includes errors that occur in the
operation of the Oracle Application Server or the Oracle AS SPI and changes made to
Oracle Application Server configuration.

¢ OASSPI-Metrics — Contains metric policies that monitor the performance levels and
availability of Oracle OC4J/OHS servers.

Each metric policy determines the threshold conditions for the monitored metric, the
message text that is sent to the HPOM message browser when the threshold is exceeded,
the actions to start, and instructions that appear.

e  (OASSPI-Metrics [JMX] — Contains metric policies that monitor the performance levels
and availability of Oracle OC4J/OHS servers. These metric policies are available only for
Oracle Application Server version 10gR3.

e (OASSPI-Monitors — Contains collector policies that specify the collection interval of the
metric policies. Within the name of each collector policy is its collection interval. For
example, the collection interval of the policy OASSPI-10-OHS-15min is 15 minutes (where
15min represents 15 minutes). Each collector policy is assigned a collection interval of 5
minutes, 15 minutes, or one hour.

When you open a collector policy, you can see the metrics collected within the interval
(listed by number, following the -m option of the collector/analyzer command wasspi ca).
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Each collector policy controls which metrics are collected when. Specifically, the collector
policy does the following:

— Runs the collector/analyzer at each collection interval
— Specifies which metrics are collected

e OASSPI-Monitors [JMX] — Contains JMX collector policies that specify the collection
interval of the JMX metric policies. These policies are only for Oracle AS version 10gR3.

e OASSPI-Messages — This is a single policy. It intercepts the Oracle AS SPI messages for
the HPOM message browser.

e The OASSPI Discovery policy group contains the following policy sub-groups and policies:
Figure 11 OASSPI Discovery Policy Group

Elements in Policy Group "SPI for Oracle AS/OASSPI Discovery"= - o -

Peolicy Bank / SPI for Cracle AS / OASSPI Discovery

QASSPI Discovery GROUP

Details OASSPI Discovery +  Filter

Found 2 Elementz

T Assigned Latest Mode
D & 0ASSPMessages 7.0 1.0 Fixed Ch- O~ OraclesS

=

=]

[] & OASSPIServics Discovery
t | Choose an action V| >3 |

e OASSPI-Messages — This is a single policy. It intercepts the Oracle AS SPI messages for
the HPOM message browser.

0 Fixed Ch O~ 0ASSPI Discovery

e  OASSPI Service Discovery: This is a single policy. It updates the configuration on the
HPOM management server and managed nodes.

Figure 12 Message Browser

Severity Dup. SUIAONE  Time R ] Mode Application MaaGrp Chiject e Text
Warning -=M-—-— 020214 08724009  |Oramsa... Oracle Applicat... OASSPI Discoverylog OASSPI181: WASSP-1 212 Updating information for an ex...
Warning -=¥-—--— 020214 08724009  10ramsa.. Oracle Applicat... OASSPI Discovery log OASSPI181: WASSP-1 221 Writing information for applicst ..
Warning -=¥-—--— 020214 08724009  10ramsa.. Oracle Applicat... OASSPI Discovery log OASSPI181: WASSP-1220; Writing global properies. [Pali...
Warning -=¥-—--— 020214 08724009  10ramsa.. Oracle Applicat... OASSPI Discoverylog OASSPI1 81 WASSP-1211: Adding & newy application ser...
Warning -=¥-—--— 020214 08724009  10ramsa.. Oracle Applicat... OASSPI Discoverylog OASSPI181: WASSP-1 210 Undating information for applic ..
so o IEEEENNGEN o s [z 0 0 L Lock
% | All Active Messages 6 Filtered Active Messages |
Seled Map Wiew Broveser displays max 50 messages. @ QD

In the message browser shown above, all the messages are generated by the Oracle AS SPI
policies that belong to the Oracle AS and OASSPI Message Groups (see the column titled
MsgGroup), indicating their origins. The Oracle AS messages indicate conditions occurring in
Oracle OC4J/OHS servers while the OASSPI message indicates a condition occurring in the
Oracle AS SPI.

For Oracle AS SPI version 6.10, you will also see another policy group called Generic JMX.
This group can be expanded into the following sub groups:

— JMX-Metrics
— JMX-Monitors
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2 Installing, Upgrading, and Removing the
Oracle AS SPI

This chapter provides the steps on how to install, upgrade, and remove the Oracle AS SPI. To
successfully install the Oracle AS SPI, you must complete all installation prerequisites and
complete the steps for install the SPI. The flowchart illustrated in Figure 13 summarizes the
steps for installing and configuring the Oracle AS SPI. See Table 1 to locate any step by

clicking on the hyperlink.
Figure 13 Flowchart on steps for installing and configuring the SPI

Fulfill the hardware and
software raguirements,

A
v l
| Fulfill the corfiguration prerequisites, E I
Mourt the OVD, B
v
| Add nodes to the node group, F | v
Install the SPI, C
| Assign categores to the managed node, G | ‘L
[ Deploy instrumeantation in the managed node, H | Verify the
pay ! : installation, D

v |
| Run the Discover tool, | | |

See Troubleshooting the
Discovery, K

I Assign policies to the managed node, L |

.

| Deploy policies on the managed node, M |

v

| Run the Conrfiguration tool, N |

i>

Table 1 References of the legends in the flowchart

A Prerequisites on page 26
B To Mount the DVD on HP-UX on page 26 and To Mount the DVD on Solaris
on page 26

C To Install the Oracle AS SPI on page 26
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Table 1 References of the legends in the flowchart

D Verifying Installation on page 27

Configuration Prerequisites on page 35

Task 1: To Add Nodes to the Oracle AS Node Group on page 38

Task 2: To Assign the Categories to the Managed Nodes on page 38

Task 3: To Deploy Instrumentation on the Managed Node on page 38

Task 4: To Run Discovery on page 39

Task 5: To Verify the Discovery Process on page 42

Troubleshooting the Discovery Process on page 83

Task 6: To Assign Policies to the Managed Node on page 43

Task 7: To Distribute the Oracle AS SPI Policies on page 43

Z g2l R|& 7l H

Task 8: To Run Configuration on page 44

The flowchart illustrated in Figure 14 summarizes the steps for installing and configuring the
Oracle AS SPI. See Table 2 to locate any step by clicking on the hyperlink.

Figure 14 Flowchart on steps for upgrading the SPI

Mo | See Limitations, A

Upgrade the management server from HFOM 8.x to HPOM 9.00, B

!

Migrate the Oracla AS 5P| version & 00
from HPOM 8 x to HPOM 900 . G

|
. .

Upgrade the Oracle AS SPI version 6.00 to .
! h . Lipgrade the Oracle AS SPI version 6.00
version 7.00 on HFOM 2.00 using Smart Plug-in to versian 7.00 through HPOM conscle, E

Upgrade Todlkit, D

Table 2 References of the legends in the flowchart

A Limitations on page 28
B Upgrade the Management Server from HPOM 8.xx to HPOM 9.0x on
page 29
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Table 2 References of the legends in the flowchart

C Migrate the Oracle AS SPI 6.00 from HPOM 8.xx to HPOM 9.0x on page 29

D Upgrading the SPI using the HP Operations Smart Plug-in Upgrade Toolkit
on page 30

E Upgrading the Oracle AS SPI on a Standalone HPOM 9.0x Server through
HPOM Console on page 30
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Prerequisites

You must install the HP Operations Manager (HPOM) management server and discovery
package before installing the Oracle AS SPI. It is not necessary to stop HPOM sessions before
beginning the Oracle AS SPI installation. For a complete list of software requirements, see the
HP Operations Smart Plug-in for Oracle Application Server Release Notes.

Installing the Oracle AS SPI on a Local Management Server

Perform the steps given in the following sections to install the Oracle AS SPI.

To Mount the DVD on HP-UX

1 Log on as user root.

2 Set the user root’s umask by entering:
umask 027

3 Create a directory to mount the DVD:
mkdir /<mount_point>

For example: mkdir /dvdrom

4 Insert the DVD into the disk drive and mount it as user root by entering:
mount /dev/<dvdrom drive name> /<mount_ point>

For example, for a local DVD, you might enter:
mount /dev/dsk/c0t2d0 /dvdrom

You can also run SAM and mount the DVD to a specific path in the Disks and File
Systems window.

To Mount the DVD on Solaris

Insert the DVD into the DVD drive. The DVD is automatically mounted (and unmounted) on
Sun Solaris systems.

The discovery package and the Oracle AS SPI are available on the HP Operations Smart
Plug-ins DVD.

The HP Operations Smart Plug-ins HPUX.depot file present under <mount point>/
HPUX/ directory is used to install the Oracle AS SPI on HP-UX Management Server. The
HP Operations Smart Plug-ins_ SOLARIS.sparc file present under <mount point>/
SOLARIS/ directory are used to install the Oracle AS SPI on Solaris Management Server.

To Install the Oracle AS SPI

The instructions that follow show the command line usage of swinstall. For HP-UX systems,
you can also use the graphical user interface (GUI), but the GUI method is not covered.

) It is not necessary to stop HPOM sessions before beginning the Oracle AS SPI installation.
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For an HP-UX 11.31 IA management server, type:

swinstall -s /dvdrom/HPUX/HP_Operations_Smart Plug-ins_ HPUX.depot
OASSPI

For a Solaris management server, type:

pkgadd -d /dvdrom/SOLARIS/HP Operations_Smart Plug-ins_SOLARIS.sparc
HPOvSpiOas

Installing the Oracle AS SPI in an HPOM Cluster Environment

You must first install the HPOM management server on each system in the cluster. When the
management server cluster installations are complete, the setup for the installation of the
Oracle AS SPI is ready.

) Before beginning, make sure that sufficient disk space (500 MB) is available on each
management server for the Oracle AS SPI you plan to install. Cancelling the installation
process before completion could result in partial installations and require manual removal of
the partially installed components.

After installing the HPOM management server, proceed as follows:

For the first installation (Node A) and all remaining installations in the cluster — Follow the
standard installation procedure by either making the product choices or typing the name of
the SPI component you want to install. Once you complete the installation on Node A, proceed
to the next node. Repeat the same procedure proceeding from one node to another until you
have completed installing the SPI on each of the nodes in the cluster.

Installing the SPI on the Cluster-Aware Management Server

Complete all the tasks in the section Installing the Oracle AS SPI on a Local Management
Server on page 26 and then proceed to the next management server until the installation on
every management server in the cluster is complete.

o The HPOM console will not function properly until installations are completed on
all nodes in the cluster.

Veritying Installation

Type the command swlist to verify the installation of the Oracle AS SPI on the management
server.
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Upgrading the Oracle AS SPI

Be aware of the following limitations when you plan to install the Oracle AS SPI 7.00 from
SPI DVD 2009 on a HPOM 9.0x, which has the Oracle AS SPI 6.00 installed from SPI DVD
2008.

Limitations

These are the following limitations for the Oracle AS SPI 6.00 support on HPOM for UNIX
9.0x:

You must complete the migration process from HPOM 8.xx to HPOM 9.0x before
upgrading the Oracle AS SPI to version 7.00. Once the Oracle AS SPI 7.00 is installed,
migrating from HPOM 8.xx is not supported.

Having the Oracle AS SPI version 6.00(migrated from HPOM 8.xx) and Oracle AS SPI
version 7.00(newly installed from SPI DVD 2009) on HPOM 9.0x is an intermediate mode
and you must move all managed nodes to the Oracle AS SPI version 7.00 as soon as
possible.

If you have multiple SPIs deployed on a managed node, the node can be monitored either
by SPI DVD 2008 SPIs or SPI DVD 2009 SPIs. Monitoring a node by combination of SPIs
from SPI DVD 2008 and SPI DVD 2009 is not supported.

If you have the Oracle AS SPI 7.00 installed on HPOM 9.0x systems, which also has the
Oracle AS SPI 6.00 as well, the following points are true.

— You must configure newly added managed nodes using the Oracle AS SPI 7.00.

— No configuration is possible on the existing or old managed nodes monitored by the
Oracle AS SPI 6.00.

This is because the Oracle AS SPI 6.00 configuration tools are overwritten by the Oracle
AS SPI 7.00 tools and these tools are incompatible.

Patches for the Oracle AS SPI version 6.00 must be installed before you start the HPOM
migration process. Once the Oracle AS SPI version 7.00 is installed, no patches or
hot-fixes pertaining to the Oracle AS SPI version 6.00 could be installed on the HPOM
server.

To invoke the GUIs related to Oracle AS SPI 7.00, you must install X-windows client
software on the machine from which you will launch the HPOM for UNIX 9.0x server
Operator GUI.

Installing patches that would be released in the future for the Oracle AS SPI version 6.00
are not supported on HPOM for UNIX 9.0x after migration. However, patch can be
installed on the HPOM for UNIX 8.xx server and migrated to HPOM for UNIX 9.0x
environment.

Migration of Java Metric Builder (JMB) to HPOM for UNIX 9.0x server is not supported.

Graph templates cannot be invoked from automatic action or Operator initiated action of
alerts.

After migration from HPOM 8.xx to HPOM 9.0x, when you run license reporting tool from
HPOM 9.0x, the following errors would be reported. This is an expected behavior. You can
ignore this error.

ERROR: (oprel-407) License status for 'SPI Name' is: Error
Can't check license status because of missing ID mapping file.
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Please install the missing component and make sure that a
sufficient number of licenses is installed.

Error: ' (oprel-130) ID mapping file does not exist: (oprel-129)
Can't find ID mapping file '/opt/OV/misc/EL/registration/<SPIname>.xml'
for plug-in '<SPIname>'. '
ERROR: (oprel-407) License status for 'SPI Name remote' is: Error
Can't check license status because of missing ID mapping file.
Please install the missing component and make sure that a
sufficient number of licenses is installed.

Error: ' (oprel-130) ID mapping file does not exist: (oprel-129)

Can't find ID mapping file '/opt/OV/misc/EL/registration/<SPIname>.xml'
for plug-in '<SPIname>'. '

) If you have installed more than one Smart Plug-ins for Web Application Server (for example,
the WebLogic SPI, WebSphere SPI, and Oracle AS SPI), make sure that the SPIs are
upgraded simultaneously on the management server because the Smart Plug-ins for Web
Application Server share common components amongst them.

This version of the Oracle AS SPI supports HPOM for UNIX 9.0x. To upgrade the earlier
versions of Oracle AS SPI to Oracle AS SPI 7.00, perform the following tasks:

e Upgrade the Management Server from HPOM 8.xx to HPOM 9.0x
e Migrate the Oracle AS SPI 6.00 from HPOM 8.xx to HPOM 9.0x
e Upgrade the Oracle AS SPI 6.00 to Oracle AS SPI 7.00 on HPOM 9.0x

Upgrade the Management Server from HPOM 8.xx to HPOM 9.0x

Read and follow the steps provided in HP Operations Manager for UNIX 9.00 Installation
Guide for migrating or upgrading HPOM for UNIX 8.xx to HPOM for UNIX 9.0x.

Migrate the Oracle AS SPI 6.00 from HPOM 8.xx to HPOM 9.0x

The instrumentation files and other SPI specific data are migrated while migrating or
upgrading HPOM for UNIX 8.xx server (where the Oracle AS SPI 6.00 is installed) to HPOM
for UNIX 9.0x. Some SPI specific data, however, must be migrated manually.

Migrate the HPOM from one system to another

Install HPOM for UNIX 9.0x on a new system. To perform the migration from one system to
another, perform the following steps:

1 After completing migrating HPOM for UNIX 8.xx to HPOM for UNIX 9.0x, create the
following directories on the target HPOM for UNIX 9.0x server:

/var/opt/0OV/wasspi/oas/
/opt/OV/SPISvcDisc/conf/OASSPI/
/opt/0OV/wasspi/oas/
/var/opt/0OV/share/conf/SPISvcDisc/OASSPI/

2 Copy the files present in the folders created in step 1 from HPOM for UNIX 8.xx to HPOM
for UNIX 9.0x server at their respective folders.
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3 Copy the following files from HPOM for UNIX 8.xx to HPOM for UNIX 9.0x server at
their respective folders:

/opt/OV/SPISvcDisc/conf/wasspi oas DiscConfig.sh

/opt/OV/newconfig/inventory/HPOvSpiOas.xml

Upgrade the Oracle AS SPI 6.00 to Oracle AS SPI 7.00 on HPOM 9.0x

You can upgrade the Oracle AS SPI either using the HP Operations Smart Plug-in Upgrade
Toolkit (SPI Upgrade Toolkit) or through the HPOM for UNIX console.

Upgrading the SPI using the HP Operations Smart Plug-in Upgrade Toolkit

The HP Operations Smart Plug-in Upgrade Toolkit (SPI Upgrade Toolkit) version 2.0 helps
you upgrade the Oracle AS SPI to a higher version while retaining the customizations done on
policies. During the Oracle AS SPI upgrade process, the SPI Upgrade Toolkit enables you to
store the modifications done on the customer version of policies. For a specific policy, the SPI
Upgrade Toolkit analyzes and compares three versions—base, customer, and factory—and
helps you select the settings of the base, customer, or factory version of the policy—depending
on your requirement. To upgrade the Oracle AS SPI using the SPI Upgrade Toolkit, follow the
instructions defined in HP Operations Smart Plug-in Upgrade Toolkit UNIX User Guide.

Upgrading the Oracle AS SPI on a Standalone HPFOM 9.0x Server through HPOM Console

To upgrade the Oracle AS SPI on a standalone HPOM 9.0x server, complete these tasks:

1 Rename the policy and tool group for Oracle AS SPI from SPI for Oracle AS to SPI for
Oracle AS_OLD. Rename both the Name and the Label (for example, OASSPI:TOOLS to
OASSPI:-TOOLS_OLD:).

2 Deassign the policies or policy groups assigned to the node.

3 Delete the old policies, instrumentation, and datasources on the node manually. The
existing data is deleted. Hence, take a backup of your existing data.

A The existing Oracle AS SPI datasource should be manually deleted when you upgrade the
SPI. For example, ddfutil /var/opt/OV/wasspi/ocas/datalog/graph.log -rm all.
A new datasource is created and the existing data is lost. The datasource is deleted
irrespective of whether you are using CODA or HP Performance Agent. When you upgrade
from a previous installation, all your configuration entries are preserved.

4 Install the Oracle AS SPI by performing the steps in Installing the Oracle AS SPI on a
Local Management Server on page 26.

5 Configure the SPI by performing the steps in Chapter 3, Configuring the Oracle AS SPI.

To Install the New Report Package (Optional)

Remove older versions of the Oracle AS SPI report package from your Windows system
running HP Reporter and install the new Oracle AS SPI report package. To install the new
report package, follow these steps:

1 On the Windows system running HP Reporter, go to Settings = Control Panel ->Add/Remove
Programs.

2 Select the Oracle AS SPI report package and click Remove.

Chapter 2



3 To install the Oracle AS SPI report package, follow the steps in Integrating with HP
Reporter on page 66.

To Install the New Graph Package (Optional)

e If HP Performance Manager is running on a Windows system, remove older versions of
the Oracle AS SPI graph package and install the new Oracle AS SPI graph package. To
install the new graph package, follow these steps:

a Go to Settings = Control Panel > Add/Remove Programs.

b Select the Oracle AS SPI graph package (HP Operations Manager SPI for Oracle AS -
Graphing Component Integration) and click Remove.

c¢ Toinstall the Oracle AS SPI graph package, follow the steps in Integrating with HP
Performance Manager on page 68.

e If HP Performance Manager is running on a HP-UX system (not the HPOM management
server), follow these steps:

) If HP Performance Manager is installed on the HPOM management server, the
files are automatically updated when you install the SPI software.

a Run swlist | grep OASSPI-GRAPHS to verify that the graph package is installed.
b Run swremove OASSPI-GRAPHS if the graph package is installed.

c¢ Toinstall the Oracle AS SPI graph package, follow the steps in Integrating with HP
Performance Manager on page 68.

e If HP Performance Manager is running on a Solaris system (not the HPOM management
server), follow these steps:

) If HP Performance Manager is installed on the HPOM management server, the
files are automatically updated when you install the SPI software.

a Run /usr/bin/pkginfo HPOvSpiOasG to verify that the graph package is installed.
b Run /usr/sbin/pkgrm HPOvSpiOasG if the graph package is installed.

To install the Oracle AS SPI graph package, follow the steps in Integrating with HP
Performance Manager on page 68.
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Removing the Oracle AS SPI

The complete removal of the Oracle AS SPI installation deletes all the Oracle AS SPI
components.

Complete the following tasks:

1 Task 1: Remove the Oracle AS SPI Software from the Management Server
Task 2: Delete the Oracle AS SPI Message Groups

Task 3: Delete the Oracle AS SPI User Profiles

Task 4: Remove the Report Package (Optional)

Task 5: Remove the Graph Package (Optional)

g A W N

Task 1: Remove the Oracle AS SPI Software from the Management Server

1 Open a terminal window and log on as root.
2 In the terminal window:
e For an HP-UX 11.31 IA management server, type:

/usr/sbin/swremove OASSPI
/usr/sbin/swremove OASSPI-GRAPHS

e For a Solaris management server, type:
/usr/sbin/pkgrm HPOvSpiOas

The swremove and pkgrm command removes the files from the software list, directories in
/var/opt/OV/share/databases/OpC/mgd node/instrumentation/, directories in
/opt/OV/wasspi/oas, node groups, categories, tools, and policies.
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Task 2: Delete the Oracle AS SPI Message Groups

1 From the Administration U, open the All Message Groups window.
2 Select OASSPI and OracleAS message groups check boxes.

3 Select Delete... from the Choose an Action drop-down list and click E to submit.
The Oracle AS SPI message groups are deleted.

Task 3: Delete the Oracle AS SPI User Profiles

1 From the Administration UI, open the All User Profiles window.
2 Select the user profiles for the Oracle AS SPI by selecting the check box.

3 Select Delete... from the Choose an Action drop-down list and click E to submit.
The Oracle AS SPI user profiles are deleted.

Task 4: Remove the Report Package (Optional)

If you installed the Oracle AS SPI report package (on your Windows system running
Reporter), remove it by following these steps:

1 On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

2 Select the Oracle AS SPI report package and click Remove.

Task 5: Remove the Graph Package (Optional)

If you installed the Oracle AS SPI graph packages (on the system running HP Performance
Manager), remove them.

¢ On a Windows system running HP Performance Manager, follow these steps:
a From the Control Panel, double-click the Add/Remove Programs icon.
b  Select the Oracle AS SPI graph package and click Remove.

¢  On an HP-UX system running HP Performance Manager that is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are removed in Task 1: Remove the Oracle AS SPI
Software from the Management Server on page 32):

a Verify that the graph package is installed. Type
swlist | grep OASSPI-GRAPHS

b Type swremove OASSPI-GRAPHS

e  On a Solaris system running HP Performance Manager that is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are removed in Task 1: Remove the Oracle AS SPI
Software from the Management Server on page 32):

a Verify that the graph package is installed. Type
/usr/bin/pkginfo HPOvSpiOasG
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b Type /usr/sbin/pkgrm HPOvSpiOasG

Removing the Oracle AS SPI in a Cluster Environment

To remove the Oracle AS SPI from each system in the cluster, follow the steps in Removing
the Oracle AS SPI on page 32.
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3 Contiguring the Oracle AS SPI

To successfully configure the Oracle AS SPI, you must complete all configuration
prerequisites, complete Oracle AS SPI configuration (for managed nodes and the management
server), and complete additional configuration based on your environment.

Configu

ration Prerequisites

Log on to HPOM as an administrator. The Administration Ul window opens. Complete the
following tasks before configuring the Oracle AS SPI:

Task 1:

1
2

Task 1: Assign Operator Responsibilities to the Operator
Task 2: Assign Tools to the Managed Nodes

Task 3: Verify the Application Server Status

Task 4: Collect Oracle AS Login Information

Assign Operator Responsibilities to the Operator

Log on to HPOM (For example, as an administrator (opc_adm)).
Select All Users — opc_adm.

The User “opc_adm” window appears.

User "opc_adm"= - o -

Capabilities
Responsibilities

Attribute Value

Name opc_adm

Label opc_adm
Dezcription HPON Adminizstrator
Type Adminiztrator

Real Name HPOM Administrator

Node Hierarchy NodeBank

Capabilities

Acknowledge

Modify Message Aftributes
FPerform actions

Own messages

Responsibilities

Message Groups
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3 To change a User’s responsibility, select Edit Responsibilities.... from the drop down list as
shown in the following figure.

User "opc_adm" = -~ & -

2 View
: g:sagg:':gli?]?lities B Edit..

‘ Copy...
Attribute f Assign Profiles...
Name ‘ Copy with Assignments...
Label a2} Assign Tools...
Description Edit Responsibilities...
Type %  Delete...
mEliEne & Inform Operator
Node Hierarchy ° L
Capabilities ™ Add to Shopping Cart

4 For OASSPI and OracleAS Message Groups, make sure all check boxes are selected.

Edit Responsibilites for User/Profile opc_adm

hp_ux net_devices VWware. VISPl) VMware...-Added)

(53

QASSPI

OpC
OpenView
Oracless
0s

Output
Performance
R3_ABAP-4
R3_ALE

R3_Backup

O0O0DRREREOERO
OO0 0DRREEOERBO
ERENEEEEERE
EEREEEEEEERHE

R3_Bufferz

1<

Config View Mark Editor m

5 Assign the OASSPI Node or Message Groups to any other appropriate operators.
6  Click Close.

Task 2: Assign Tools to the Managed Nodes

1 Open the Tool Bank window and select the SPI for Oracle AS tool group.
2 Select Assign to User/Profile... from the Choose an Action drop-down list and click [Egd to
submit.
The Selector window opens.
Click All Users.
4  Select the operator to which you want to assign the tools.
Click OK.
The Oracle AS SPI tools are assigned to the operator.
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Task 3: Verify the Application Server Status

For each managed node, verify that the application servers are running by checking a server’s

status from the Oracle Application Server Control Console.

ORACLE Fll'l.‘lfllllfir! Mﬂha“l:r 1ﬂ[f

Application Server Contr

Legs Topology Preferences Help

Earmm =»

Application Server; testappsi.test.com

Home 2EE Applications Pors T :
General CPU Usage
AL Stop All | |_Restart All

i e WETEE )

i Status Up

H ot 111-
! 1 owlest adapps hp com
- 513"?::: Paortal and Wireless

Oracle
Home
Farmm

O 1die (0%)
B otver (100%)

Coracle bi

System Components
. EnableiDizable Components |

B Application Serer (0%)

Configure Component |

Page Refrashed May 10, 2005 1:43:29 AME.

Memory Usage

B Application Senver (0% DMB)
O Fras (3% 134ME)
Wl Other (37% 3,969ME)

Create OC4.) Instance |

Elan | | Sop ) | Restan | | Delele OC 4 Instance |

Task 4: Collect Oracle AS Login Information

If security is enabled on the Oracle AS, collect the Oracle AS login and password for each
0OC4J/OHS server. If you do not want to use the existing login and password, create a new
login and password. The Oracle AS SPI discovery process uses the login and password to
gather basic configuration information, and the Oracle AS SPI data collector uses the login

and password to collect metrics.

OHS servers similar.

To simplify the Oracle AS SPI configuration, keep the login and password for both OC4J and

You can use the username and password for users/groups assigned to the administrator or

operator role.
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Oracle AS SPI Configuration

To configure the Oracle AS SPI, complete the following tasks (from the management server):
1 Task 1: To Add Nodes to the Oracle AS Node Group

Task 2: To Assign the Categories to the Managed Nodes

Task 3: To Deploy Instrumentation on the Managed Node

Task 4: To Run Discovery

Task 5: To Verify the Discovery Process

Task 6: To Assign Policies to the Managed Node

Task 7: To Distribute the Oracle AS SPI Policies

Task 8: To Run Configuration

Task 9: To Verify the Oracle AS SPI Configuration

O 0 N o0 0 A WN

Task 1: To Add Nodes to the Oracle AS Node Group

The Oracle AS SPI automatically creates a single node group (Oracle AS) with appropriate
policy groups already assigned. Place any nodes running Oracle OC4J/OHS servers in this
node group.

1 Open the Node Group window and select the Oracle AS node group.

2 Select Assign Nodes... from the Choose an Action drop-down list and click to submit.
The Selector window opens.

3 Click All Nodes.

4 Select the managed nodes running Oracle OC4J/OHS servers.

5 Click OK.

Task 2: To Assign the Categories to the Managed Nodes

1 Open the Node Bank window and select the managed nodes.

2 Select Assign Categories... from the Choose an Action drop-down list and click [g&d to
submit.

The Selector window opens.

3 Select the Oracle, OASSPI Discovery (optional), JMX, SHS_Data_Collector, and
SPIDataCollector categories.

4 Click OK.

Task 3: To Deploy Instrumentation on the Managed Node

1 From the Node Bank window, select the nodes or node groups on which you want to install
the Oracle AS SPI.
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2 Select Deploy Configuration... from the Choose an Action drop-down list and click [g&d to

submit.
Node Bank= - o -
__________________________________________________________________________________ &
Found 3 Elements |
A B - o £ e H i Distribute Policies O *
| Distibute Actions o -
[ | Distribute Monitors O =
O ;: Holdingdrea Huldingﬁ.\rea : Distribute Commands 0 *
O _f‘ =l _ ;ﬂi-ﬂ_ss.gi_m_ Distribute Instrumentation O 2
e — Im; Distribute Subagents [l 2
L Deploy Configuration... * m: Force |:|
Found 3 Elements E PIRE D
==

3 Select Distribute Instrumentation check box.

4 Click OK.

Task 4: To Run Discovery

You must run discovery using the Discover or Configure OASSPI tool to set the basic
configuration properties required for the Oracle AS SPI to discover instances of the Oracle

Application Server, deploy the Oracle AS SPI discovery policies, and update the service map.
Follow these steps:
1 From the Administration Ul, select Integrations = HPOM for Unix Operational Ul.

2  Select one or more nodes on which you want to launch Discover or Configure OASSPI tool.
To invoke Oracle AS GUIs. see Important: on page 135.

3 Right-click a node and select Start = SPI for Oracle AS = SPI Admin — Discover or Configure
OASSPI.

The Tool Selector window opens.

4  Select the Launch Discover Tool radio button and click OK. By default, the Launch
Configure Tool radio button is selected.

The Introduction window opens.
5 Click Next.
The Configuration Editor opens.

6 Ifyou have already set the LOGIN, PASSWORD, HOME or HOME_LIST, and
JAVA_HOME properties, go to the step 7.

If you have not set the LOGIN, PASSWORD, HOME or HOME_LIST, and JAVA_HOME
properties, perform the following steps to set these mandatory properties.

Make sure that the LOGIN, PASSWORD, JAVA_HOME, and HOME or
HOME_LIST properties are set because these are mandatory properties. In earlier
versions of the SPI, only LOGIN and PASSWORD were required properties.

a  Select LOGIN/PASSWORD from the Select a Property to Set... drop-down list.
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>»

>»

The Set Access Info for Default Properties window opens.

Enter the username and password collected in Task 4: Collect Oracle AS Login
Information on page 37. The LOGIN and PASSWORD properties are set to this
information.

The LOGIN and PASSWORD properties set in this window are used as the default
Oracle Admin Server login and password (they are set at the global properties level).
That is, if no NODE level or server-specific LOGIN and PASSWORD properties are
set, this Oracle AS login and password are used by the Oracle AS SPI to log on to all
Oracle Admin Servers. For more information about the configuration structure, see
Structure on page 117.

If the Oracle Admin Server login and password are the same for all Oracle
application servers on all HPOM managed nodes, set the LOGIN and PASSWORD
properties in the Set Access Info for Default Properties window and click OK.

If the Oracle Admin Server login and password are different for different
instances of Oracle, you must customize the Oracle AS SPI configuration by setting
the LOGIN and PASSWORD properties at the NODE or server-specific level (for more
information about the configuration structure, see Structure on page 117) and click
OK:

Select HOME or HOME_LIST from the Select a Property to Set... drop-down list and
click Set Property. Set the value for HOME or HOME_LIST.

Select JAVA_HOME from the Select a Property to Set... drop-down list and click Set
Property. Set the value for JAVA_HOME.

7 Modify the configuration using configuration editor.

) When setting the configuration using configuration editor, note the following:

e GRAPH_SERVER property is no longer supported in the Oracle AS SPI.
Instead, set the GRAPH_URL property.

e After you consolidate the UDMs on the management server, delete the old
UDM files from the managed nodes and distribute the new UDM file to the
managed nodes using the Deploy UDM tool.

8 Click Next to save any changes and exit the editor.
9 The Confirm Operation window opens. Click OK.

If you click Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes, start the Discover or Configure OASSPI
tool, launch the Discover tool, click Next from the configuration editor, and then click OK.

Do not close the Discover or Configure OASSPI tool window until the discovery process
completes. The discovery process might take several minutes to complete.

JMX Discovery for Oracle AS

The Oracle AS SPI now supports JMX discovery for Oracle Application Server version 10gR3.

In your environment you may have different versions of Oracle Application Servers, for
example, version 10gR3 or older, installed on the same node. In such a scenario, you may have
to select whether you want to run classic discovery or the JMX discovery.

For the older versions of Oracle Application Servers, the Oracle AS SPI uses DMS tool for
Discovery. This is referred to as classic discovery in this document.
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There can be three scenarios:

Scenario 1: If only Oracle Application Server version 10gR3 is installed on the node.

By default, the JMX Discovery runs.

Scenario 2: If Oracle Application Server versions older than 10gR3 (for example10gR1 and 10gR2) are
installed on the node.

By default, the classic system of discovery runs.

Scenario 3: If different versions of Oracle Application Server (10gR3 along with 10gR1 or 10gR2) are
installed on the node.

You can choose the method of discovery.

In the SPIConfig file, set the value of the JMX_DISCOVERY flag to true or false. By default,
the value is true.

e If JMX_DISCOVERY=true, the JMX Discovery runs for Oracle AS 10gR3 version only and
all the older versions are not discovered.

e If JMX_DISCOVERY=false, the classic system of discovery is used for all the versions
including 10gR3.

) If you set the JMX_DISCOVERY flag to false, the collection of JMX Metrics (belonging to the
OASSPI-Metrics (JMX) policy group) fails. All metrics belonging to the OASSPI Metrics
group is collected with the exception of OASSPI_0001, OASSPI_0002, OASSPI_0005, and
OASSPI_0245.

Discovering HTTP (OHS) Server

) The new JMX discovery discovers the HTTP server only if it is a part of a cluster.

There can be two discovery scenarios for HT'TP (OHS) servers:

Scenario 1: HTTP (OHS) and OC4J servers are on the same system and have a common Oracle HOME.

The HTTP server is automatically discovered.

Scenario 2: HTTP (OHS) and OC4J servers are on different systems and /or have different Oracle
HOME.

Follow these steps:
1 In the cluster, identify the OC4dJ instance that is connected to the OHS server.

2 In the Configuration Editor (see Using the Configuration Editor on page 119 for more
information about the configuration editor) right-click the node on which the OC4dJ server
is installed and select Add OC4J/OHS Server. The OASSPI Discover Tool: Add App Server
window opens.

3 Select the HTTP Server check box and click OK. The HTTP Server is added below the OC4J
server.

4  Select the HTTP Server. In the Properties for OC4J/OHS Server: HTTP Server pane, the
NAME and TYPE properties appear by default.
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Set the following properties—to set a property select the property from the Select a
Property to Set drop-down list and click Set Property. Double-click the empty space next to
the property after the property appears in the list:

— HOME: Similar to the value set for the OC4dJ server.
For example: E: /product/10.1.3.1/0OracleAsS 1

— JAVA_HOME: Similar to the value set for the OC4dJ server.
For example: E: /product/10.1.3.1/0OracleAS_1/jdk

— LOGIN: Similar to the value set for the OC4dJ server.
— PASSWORD: Similar to the value set for the OC4dJ server.
— MAP_KEY_PREFIX: Any unique HTTP instance name

— URL_PATH: Similar to the value set for the OC4d server. However, you must replace
/home at the end of the URL with /cluster.
For example: /optmn://testsystem.com:6004/cluster

To get the port no. in the URL, type the following command from the command
prompt: <directory> /product/10.1.3/OracleAS_1/opmn/bin> opmnctl
status —-port.

— VERSION: 10.1 3

Note that there is a single space between 10.1 and 3 in the version.
Click Next. The OASSPI Discover Tool: Confirm Operation Window opens.
Click OK.

) There are two limitations in this scenario:

1

You must manually enter the information the SPI requires to monitor the HTTP server.

2 The information about the HTTP Server does not appear in the service map because this

information was manually entered and not discovered.

Task 5: To Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification takes several
minutes to complete.

1

Verify that the following message appears in the message browser for each managed node:
WASSPI-602 - OASSPI Discovery is successful.

Depending on the number of managed nodes in your environment, it might take several
minutes for these messages to appear for all managed nodes.

Select File > Reload Configurations. In the Services tree, open the Application node and
look for the Oracle service. Click Services tab to view the service map in the Operational
UL

) If the service map is not displayed in the Operational UlI, type the following command to
assign the services to the operator:

opcservice -assign <operator> <service>

For example: opcservice -assign opc_adm <service>
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3 Run the Discover or Configure OASSPI tool to verify the properties set by the discovery
process. For more information about the configuration editor, see Discover or Configure
OASSPI on page 136.

Task 6: To Assign Policies to the Managed Node

1 Open the Node Bank window and select the managed nodes.
2 Select Assign Policies / Policy Groups... from the Choose an Action drop-down list and click

b to submit.

The Selector window opens.

Selectar =]

]
]
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Click Policy Bank.

4  Select the policies you want to assign to the managed node from the SPI for Oracle AS
policy group.
5 Click OK.

Task 7: To Distribute the Oracle AS SPI Policies

1 Open the Node Group window and select the Oracle AS node group.

2 Select Deploy Configuration... from the Choose an Action drop-down list and click Egd to
submit.

3 Select Distribute Policies.

4 Click OK.
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The Oracle AS SPI policies are now distributed to the Oracle AS node group. The Oracle AS
SPI monitors can now begin running according to their specific collection interval.

) If you use HP Reporter, see Chapter 5, Integrating HPOM Reporting and Graphing Products
with the Oracle AS SPI, for information on integrating the Oracle AS SPI with Reporter. Use
Reporter to generate Oracle Application Server reports that show more consolidated
information.

Task 8: To Run Configuration

1 From the HPOM console, select Integrations - HPOM for Unix Operational Ul.

2 Select one or more nodes on which you want to launch Discover or Configure OASSPI tool.
To invoke Oracle AS GUIs. see Important: on page 135.

3 Right-click a node and select Start = SPI for Oracle AS = SPI Admin — Discover or Configure
OASSPI.

The Tool Selector window opens.

4 Click OK. By default, the Launch Configure Tool radio button is selected.
The Introduction window opens.

5 Click Next.
The Configuration Editor opens.

) Make sure that the LOGIN, PASSWORD, JAVA_HOME, and HOME or
HOME_LIST properties are set. You cannot proceed to the next window if the
required properties are not set. See Task 4: To Run Discovery on page 39 for
information on how to set the properties.

6 Set the configuration properties at the global or server specific level by selecting the
property from the Select a Property to Set... drop-down list, click Set Property, and set the
value for the property. For more information on the usage of configuration editor, see
Appendix B, The Configuration.

7 Click Save to save any changes made to the configuration. After you save the changes, you
cannot undo the changes automatically.

8 Click Finish to exit the editor and start configuring the Oracle AS SPI on the managed
node.

) If you click Cancel, the changes made by you are not saved to the selected managed nodes’
configuration and remain in the configuration on the management server.

For more information about the configuration structure, see Structure on page 117.

Task 9: To Verify the Oracle AS SPI Configuration

Run the Verify tool to verify whether all the instrumentation files are properly deployed. For
more information about this tool, see Verify on page 139.

1 From the HPOM console, select Integrations - HPOM for Unix Operational Ul.
2 Select one or more nodes on which you want to launch Verify tool.

3 Right-click a node and select Start > SPI for Oracle AS - OASSPI Admin — Verify.
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Additional Oracle AS SPI Configuration

Based on your Oracle Application Server configuration and tool needs, you must finish the
Oracle AS SPI configuration by setting additional configuration properties and/or installing
and configuring additional components. Setting additional properties and configuring
additional components depends on your environment.

Conditional Properties

Based on your Oracle Application Server configuration and tool needs, you might need to set
one or more conditional properties. If you meet a condition, set the properties listed to the
right of the condition (these properties are not automatically discovered by the discovery
process). For more information about the properties, see Configuration Properties on

page 128.

Table 3 Conditional Properties

Condition Property to Set

Start or stop an Oracle Application Server using the Start/ START _CMD, STOP_CMD,
Stop Oracle AS tool from the HPOM console. and USER

Use the View Graphs tool from the HPOM console GRAPH_URL

(Performance Manager must be installed).

Setting Conditional Properties

To set the conditional properties, perform the steps in Task 8: To Run Configuration on
page 44.

Configuring a Non-Root HTTPS Agent on a UNIX Managed Node

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node,
follow these steps:

) You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo
is free software available from http:/www.sudo.ws. The OS-dependent software packages
are located at the bottom of the download page (http:/www.sudo.ws/sudo/download.html).
See the release notes for more installation information.

1 Switch the HTTPS agent to a non-root user. For more information, see the HP Operations
Manager HTTPS Agent Concepts and Configuration Guide. This document is available at
http://h20230.www2.hp.com/selfsolve/manuals under the product Operations for
UNIX, version 8.x.

2 Add the agent user account to the local Oracle Application Server user group on the
managed node. This enables the HP Operations agent user access to the files in the Oracle
Application Server installation directories. Use the system administration tool or modify
the /etc/group file to add the user.

3 On the managed node, set the OV_SUDO variable. As root or with HP Operations agent
user privileges, follow these steps:

a Stop all HP Operations agents. Run the following command:
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opcagt -kill
Set the OV_SUDO variable. Run the following command:
ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

where <sudo_program> is the location (including the absolute pathname) where sudo
is installed (for example, /usr/local/bin/sudo).

Start the HP Operations agents. Run the following command:
opcagt -start

Verify OV_SUDO is set. Run the following command:
ovdeploy -cmd set | grep SUDO

The following message appears:

OV_SUDO=<sudo_program>

Configure the managed node. These steps must be completed to successfully run the SPI
in a non-root HTTPS agent environment.

a

From the HPOM management server, deploy actions, commands, and monitors to the
managed node.

From the HPOM console, select Integrations - HPOM for Unix Operational UI.

Select one or more nodes on which you want to launch Init Non-Root tool.

Right-click a node and select Start > SPI for Oracle AS > OASSPI Admin —> Init Non-Root.
The Init Non-Root Output window opens.

Edit the /etc/sudoers file using the visudo editor (installed with sudo):

On the managed node, log in as root.
Open the /<SPI_Config_DIR>/wasspi_sudoers file

where <SPI_Config_DIR> is the location of the SPI’s configuration files on a managed
node. For more information, see Managed Node File Locations on page 115.

In a separate window, run the visudo command (for example, type:
/usr/local/sbin/visudo).

C

From the wasspi sudoers file, copy and append the following lines to the sudoers
file:

Cmnd Alias OASSPI ADMN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi admin *

Cmnd Alias OASSPI_COLL
wasspi ca *

Cmnd Alias OASSPI DISC
wasspi oas_discovery.pl
Cmnd Alias OASSPI LFEN = /opt/OV/nonOV/perl/a/bin/perl -S \
wasspi ocas le *

Cmnd Alias OASSPI SHSC = /opt/OV/nonOV/perl/a/bin/perl -S \
shs collector.pl *

/opt/OV/nonOV/perl/a/bin/perl -S \

/opt/0OV/nonOV/perl/a/bin/perl \

Cmnd Alias OASSPI_ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi admin *

Cmnd Alias OASSPI_COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi ca *

Cmnd Alias OASSPI DISCP = /opt/OV/nonOV/perl/a/bin/perl \
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/var/opt/OV/bin/instrumentation/wasspi oas discovery.pl

Cmnd Alias OASSPI LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi oas le *

Cmnd Alias OASSPI SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs collector.pl *

<OV_Agent username> <nodename> = NOPASSWD: OASSPI ADMN, \
OASSPI COLL, OASSPI DISC, OASSPI LFEN, OASSPI SHSC, \
OASSPI ADMNP, OASSPI COLLP, OASSPI DISCP, OASSPI LFENP, \
OASSPI SHSCP

In this instance, <OV_Agent_username> is the HP Operations agent user account and
<nodename> is the name of the managed node.

d Save the file and exit the visudo editor. Type :wq
) Steps 3 and 4 must be performed every time the agent user is switched.
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4 Customizing the Oracle AS SPI Policies

As you become familiar with the Oracle AS SPI, you can determine which policies are most
useful to you and which you might want to change. This chapter provides more detail on the
policies and how to make those changes.

Basic Policy Customizations

After you begin using the Oracle AS SPI, you might decide that specific Oracle AS SPI policies
need some modification. Basic customizations, such as changing a threshold (by modifying a
metrics policy) or modifying alarm generation, are covered in this section.

) Make copies of the default policies so that they remain intact. Otherwise, your customizations
are overwritten when you upgrade to the next version.

Modifying Metrics Policies

Many metric attributes can be modified for all monitored instances of Oracle OC4J/OHS
servers by following these steps:

1
2
3

Open the Policy Bank window.
Click SPI for Oracle AS > OASSPI - OASSPI-Metrics policy group.

Select a metric and click Edit... from the drop-down list.

The drop-down list appears as -
The Edit Measurement_Threshold Policy “Metric Name” window opens.
Click the Thresholds tab.
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6  Click the condition you want to modify.

Edit Measurement_Threshold Policy "OASSPI_0005"
Properties | Source ] Message Defoults [RUTETE

Use Instance Fiters

I | 1 OASSPHI005.1: Critical Threshold

D 2 QASSPI0005.2: Major Threshold

t

Manitoring T‘,rpe

» Threshold 1
o Threshold Start Actions Continue Actions End Actions

%

Description OASSPI-D005.1: Critic|=

Short term peak behaviour: | No special treatment v |

Regetl Use same a5 threshold value W |

7  Click the different tabs (Threshold, Start Actions, Continue Actions, and End Actions) and
modify the attributes. See Table 4 for a list of attributes that you can modify.

8 Click Save to save the changes.
9 Deploy the modified policy as described in Task 7: To Distribute the Oracle AS SPI

Policies on page 43.

Table 4 Metric Attributes

Attributes Description

Threshold Enter a value for the metric data that, when exceeded, would
signify a problem either about to occur or already occurring.

Duration The length of time that the established threshold can be
exceeded by the incoming data values for a metric before an
alarm is generated.

Severity The level assigned by the HPOM administrator to a
message, based on its importance in a given operator’s
environment. Click Severity to select the desired severity
setting.

Message Text Structured, readable piece of information about the status of

a managed object, an event related to a managed object, or a
problem with a managed object. Be careful not to modify any
of the parameters—surrounded by <> brackets, beginning
with $—in a message.
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Table4  Metric Attributes

Attributes Description

Actions Response to a message that is assigned by a message source
policy or condition. This response can be automatic or
operator-initiated. This section provides the ability to
generate Performance Manager graphs or reports, or to add
custom programs.

Automatic action Action triggered by an incoming event or message. No
operator intervention is involved. The automatic action
delivered with the Oracle AS SPI generates a snapshot
report that shows the data values at the time the action was
triggered from an exceeded threshold. You can view the
report in the message Annotations.

Operator-initiated action | Action used to take corrective or preventive actions in
response to a given message. Unlike automatic actions, these
actions are triggered only when an operator clicks a button.
The operator-initiated action delivered with the Oracle AS
SPI enables you to view a graph of the metric whose
exceeded threshold generated the message along with other
related metric values (click Perform Action within a message’s
details window).

Figure 15 shows a threshold setting of 95 for metric OASSPI-0005.1. This metric monitors the
percentage of heap space used in the JVM. A value of more than 95 (but less than 98) for 20
minutes would generate an alarm (a message of the severity major).

Figure 15 Threshold Value for OASSPI 0005.1

Name 0ASSPL_0005
Type external
Description JWN Heap Memory Utilization - Percent

Condition No.1 - OASSPI-0005.1: Critical Threshold (match)
Match

1 match OASSPL0005.1: vV ¥ Threshold 58
Critical Threshold Set (start)
2 match QASSPLO00S.2: Major ¥ ¥ - - ¥ geverpy 6 critical
Threshold
== Application Oracle Application Server
Content 0ASSPI0005.1: % of heap space used (<3VALUE=%) too high (>=<3THRESHOLD=%) [Policy: <SMAME=] [Policy: <SNANME=]

Message Key  <SNAME=<3MSG_NODE_NAME><=3MSG_OBJECT=

Meszage key  “<SNAME=<SMSG_NODE_NAME=<SMSG_OBJECT=%(ignore case)
relation

Service name  <SOPTION(=ervice_key)=

Actions
Operator Topt/on pi pi_xterm -e fopt/O\ pil pi_optaction_graphs <SMSG_NODE_NAME= "<SOPTION
Inttiated Action  (servername)=""JWM Memory Utmzatlun (execute on node <80PC_MGMTSV>)(creates annotation)
Automatic wasspi_perl_su -5 wasspi_ca -r-m 5 -i "<3OPTION(servernamej>" £} -(execute on node <SMSG_NODE_NAME=){creates

Action annotation)
(Send message @

after automatic

action finished)

Set (end)
TEETL @ normal
Application Oracle Application Server
Content OASSPI0005.1: % of heap =pace uzed (<SVALUE>=%) too high (>=<STHRESHOLD=%) [Policy: <SNAKME>] [Policy: <SNAME:=]

Meszage Key  <SNAME=<SMSG_NODE_NAME=<SMSG_OBJECT=

Message key  “<SNAME==SMSG_NODE_NAME=:=SMSG_OBJECT=S{ignore case)
relation

Service name  <SOPTION{gervice_key)>

Server logonly on

Modifying Alarm Generation

An alarm can be generated once or multiple times, depending on its Message Generation
setting in the Modify Threshold Monitor window.
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To change the Message Generation, follow these steps:
1 Open the Policy Bank window.
2  Click SPI for Oracle AS »> OASSPI > OASSPI-Metrics policy group.

3 Select a metric and click Edit... from the drop-down list.

The drop-down list appears as O~
4  The Edit Measurement_Threshold Policy “Metric Name” window opens.
5 Click the Thresholds tab.

6  Click the condition to modify the settings for message generation.

Edit Measurement_Threshold Policy "OASSPI_0005"

Properties m Message Defaults Thresholds
Uze Instance Fiters Monitoring Type

1 OASSPLO00S.1: Critical Threshold () Threshold 1
| S
Threshaold Start Actions Continue Actions End Actions

Description CASSPI-0005.1: Critic) =

Short term peak behaviour: | Mo special treatment hd |

D 2 DASSPI0005.2: Major Threzshold LW

-1
(R CE——

RESE!tl Use same a3 thrashold valuse W |

7 Modify the Message Generation settings by selecting the required option from the Reset
drop-down list:

e Use Same as threshold level: Alarms are generated once when the monitoring
threshold value is exceeded. Alarms reset automatically when metric values are no
longer in violation of the thresholds and are generated again when the threshold is
exceeded.

e Specify a special reset value...: Alarms are generated once when the threshold
value is exceeded. At the same time, a reset threshold value is activated. Only when
the reset threshold value is exceeded does the original threshold value become active
again. Then, when the threshold value is again exceeded, another alarm is generated
and the process starts all over again.

8 Click Save.

9 Re-distribute the modified policies as described in Task 7: To Distribute the Oracle AS SPI
Policies on page 43.

Advanced Policy Customizations

The policy changes suggested here range from making copies of default policy groups in order
to customize a few settings, to deleting whole groups of metrics within a policy’s command
line. This section is considered advanced because all changes described here, whether simple
or complex, require some advanced knowledge of the Oracle AS SPI metrics.
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Choosing Metrics To Customize

Determine which metrics you want to customize and what policies within the group you want
to use. Then, follow these steps:

1 Open the Policy Bank window and click SPI for Oracle AS.

2 Select the policy group you want to use and click Copy... from the drop-down list.

The drop-down list appears as -

The Copy Policy Group window opens.

3 Rename the group, select the parent group and click Save to save.

4 Within the renamed policy group, copy each original policy and rename it (follow the steps

2 and 3).

5 Delete the original policies within the renamed policy group by selecting Delete... from the

Choose an Action drop-down list and click E to submit.

6 Customize the renamed policies within the group as necessary.

Creating a new policy group enables you to keep custom policies separate from the original
default policies, which you copy and place within the new group.

Using the Oracle AS SPI Collector/Analyzer Command with Parameters

The wasspi ca command is used in every collector policy, named according to its collection
interval. You can view the default command line parameters within each collector policy in
the Command box in the Modify Scheduled Action window.

Using the Collector Command Parameters

The Oracle AS SPI data collections are started with the wasspi ca command, to which you
can add other parameters, as identified in the following table.

Parameter

Function

Syntax with Example

(exclude) Enables you to
exclude specific servers. This
option must not be used with
the -i option.

—e <Sserver_name>

Example: -e server2, server4

(include) Enables you to list
specific servers to monitor.
This option must not be used
with the -e option.

-1 <server_name>

Example: -i serverl, server3

—-m

(metric) Specifies the metric
numbers or number ranges
on which to collect data.

-m <metric_number | metric_number_range>
Example: -m 1,3-5,9-11,15
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Parameter

Function

Syntax with Example

-matchver

(match version) Specifies the
specific Oracle OC4J/OHS
server version to monitor.
This option must not be used
with the -minver nor
-maxver options. If no
matching versions are found,
the command does not start.

-matchver <version_number>
Example: -matchver 10.1.2

—maxver

(maximum version) Specifies
the highest Oracle OC4dJ/
OHS server version to
monitor. Use with -minver to
specify a range of versions. If
no versions are found, the
command does not start.

-maxver <version_number>

Example: -maxver 10.1.2

-minver

(minimum version) Specifies
the lowest Oracle OC4J/OHS
server version to monitor.
Use with -maxver to specify
a range of versions. If no
versions are found, the
command does not start.

-minver <version_number>

Example: -minver 10.1.2

(report) Generates an ASCII
report for the specified
metric(s).

(tag) Creates a new policy
group by adding a prefix to
an existing collector policy
and specifying the metric
number(s).

-t <prefix>-

Example: wasspi ca -prod oas -m 220-223

-t DEV-

-prod

(product) Identifies the
SPI(s) on which the
command is run on the node.

-prod <name of the SPI>-

Example: wasspi ca -prod oas -m 220-223

-t DEV-
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Parameter | Function Syntax with Example

-x Enables you to specify a -x <property>=<property_value>
property/value as follows:

alarm: When off, overrides -x alarm=off
any alarming condition as set
up in the metric monitor
policy.

prefix: Default: JMXUDM_. | -x prefix=SALES
Specifies the prefix of the
metric ID.

print: When on, prints the -x print=on
metric name, instance name,
and metric value to STDOUT
in addition to any configured
alarming or logging.

X

log: When off, prevents -
graphing or reporting
functions.

log=off

Syntax Examples
e To collect specific data on all configured servers:
wasspi ca -prod oas -m 1,2,10,11 -minver 10.0
e To collect data from specific servers only:
wasspi ca -prod oas -m 1,2,10,11 -minver 10.0 -i serverl, server2
e To not collect data from specific servers:

wasspi ca -prod oas -m 1,2,10,11 -minver 10.0 -e serverl, server2

Changing the Collection Interval for All Metrics

To change the collection interval for all monitored metrics, change the Polling Interval in the
appropriate collector policy. For example, to change the collection of default metrics from 5
minutes to 10 minutes for the OASSPI-OHS-05min collector policy, follow these steps:

1 Open the Policy Bank window.
2 Click SPI for Oracle AS > OASSPI - OASSPI-Monitors.
3 Select the monitor policy OASSPI-OHS-05min and click Edit... from the drop-down list.

The drop-down list appears as o
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4

10
1

The Edit Scheduled_Task Policy “OASSPI-OHS-05min” window opens.

Edit Scheduled_Task Policy "OASSPI-OHS-05min"

Name OASSPI-OHS-05min .

Type N

Verzion Auto-inorement on save b
Description Runs the Oracle AS 10g SPI (HTTP_Server)

collectorfanalyzer every S minutes

2]

Change the Name to OASSPI-OHS-10min and the description accordingly.
Click the Scheduled Task tab.

In the Minute box, change the polling interval from 5 minute to 10 minutes. For example,
0, 10, 20....

Click the Message Failed tab.
Change the message text.
Click Save to save the changes.

Distribute the new policies (described in Task 7: To Distribute the Oracle AS SPI Policies
on page 43).

Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector policy and
rename with a name reflecting the new interval, deleting all but the metrics you are changing.
Set the new interval. Edit the original policy to remove the changing metrics. For example, to
change the collection interval to 10 minutes for metrics 10 and 11, you would follow these
steps:

1
2
3

Open the Policy Bank window.
Click SPI for Oracle AS > OASSPI - OASSPI-Monitors.
Select the monitor policy OASSPI-OHS-05min and click Copy... from the drop-down list.

The drop-down list appears as -

The Copy Policy “OASSPI-OHS-05min” window opens.

Change the Name to OASSPI-OHS-10min and the description accordingly.
Click the Scheduled Task tab.

In the Minute box, change the polling interval from 5 minute to 10 minutes. For example,
0, 10, 20....
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7 In the Command text box, delete all metrics after the -m except 10 and 11.
Tazk | Command |w
Command wasspi_perl_su -5 wasspi_ca -m 1,2,10,11 -type chs x
Execute under Agent Acoout (SAGENT_USER) W (=
8 Click Save to save the changes.
9 In the OASSPI-Monitors policy group, select the OASSPI-OHS-05min policy.
10 Click Edit... from the drop-down list.
The drop-down list appears as 2 -
The Edit Scheduled_Task Policy “OASSPI-OHS-05min” window opens.
1 Click the Scheduled Task tab.
12 Delete 10 and 11 from the Command text box.
13 Click Save to save the changes.
14 Re-distribute the modified policies as described in Task 7: To Distribute the Oracle AS SPI

Policies on page 43.

Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you might want to set the threshold to 90 for
SERVER_1 for metric 0220 and leave the threshold at 100 for all other servers. To do so, copy
the existing condition and modify it to serve as the exception. Follow these steps:

1

Double-click to open the metric for customization (for example, OASSPI-0220).
The Message and Suppress Conditions window is displayed.

Select the desired condition and click Copy... to make a copy of the condition.
Name the condition OASSPI-0220.2.

In the Object Pattern field, enter the following details:
<ServerName>:<ServerPort>:<NodeName>:<*>:<*>:<*>

For Example: If you want to set threshold for the application server SERVERI1, enter the
following:

SERVER1 : <*>:<*¥>:<*¥> 1 <*x> 1 <*>

Click the Test Pattern Matching... to test the pattern and verify pattern matching (you must
set up a match file first).

Change the value in the Threshold field from 100 to 90.

Creating Custom, Tagged Policies

Another advanced customization option is to use the tag option (-t on the command line),
which enables the collector/analyzer to recognize customized policies that have a tag attached
to the name. This option provides you with the flexibility of using more than a single set of
policies to define conditions pertaining to specific installations of Oracle Application Server.
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When multiple nodes are managed by a number of groups, this option enables you to create
specially tagged policies that are obviously separate from your original setup. In such a case,
you would make copies of the policies, rename them with the tag and re-work the collector
policy to pick up the tagged names, and then assign them to the various groups.

For example, you can create a group of policies and change each policy name to include
CLIENTO1 in it. A metric monitor policy can be named CLIENT01-OASSPI_0001 (retaining
the metric number, which must be used). The collector policy name would be named
FIRST_CLIENT-OHS-05min. You could then set up another group for SECOND_CLIENT and
change all those policies to include the CLIENTO02 in the name.

To create the new policy group, follow these steps:

1 Copy the original policy group. In the Policy bank window, select the group, and click
Copy... from the drop-down list.
The drop-down list appears as 3 -
The Copy Policy Group window opens.

2 Name the new group according to how you plan to identify the new monitor and collector
policies. For example, if you are including CLIENTO1 in the policy names, include
CLIENTO1 within the new policy group name as well.

3 In the Policy bank window, click the policy groups to show all policies and select each
policy you plan to use, click Copy... from the drop-down list (as given in step 1 and 2), and
rename it according to your naming scheme.

e The names you give the new metric monitor policies in the group would contain the
new name followed by the original metric number. For example, a copy of
OASSPI-0001 could be called CLIENT01-OASSPI_0001.

e The name you give the new collector monitor policy would also contain the identifying
name. You would also modify the scheduled collection for the new group by inserting
the -t property on the command line. For example:

wasspi ca -m 16 -t CLIENTO1-

4 Delete all original policies from the new group.

Policy Variables

The following variables are used by the Oracle AS SPI policies. If you are creating your own
policies, you can use these variables.

Name Description

instancename The instance for which the metric is being reported for
multi-instance metrics.

Example: /oc47j/Petstore/EJBs/shoppingcartEjb.jar/
TheCart/ejbActivate
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Name Description

node The node on which the OC4J/OHS server is running.

Example: mool.hp.com

servername The OC4J/OHS server name. Corresponds to the NAME
configuration property.

Example: my server

service_key The service ID used to light up the nodes in the service map.

Re-install the Oracle AS SPI Policies

When the Oracle AS SPI policies are installed in HPOM, the following commands
automatically upload them when swinstall is run. Any customized policy settings you did for
the previous installation are overwritten.

To restore the default SPI for Oracle AS policy group you had originally installed, delete all
current policies first, then run the command:

/opt/OV/bin/OpC/opccfgupld -silent -replace
-subentity /var/opt/OV/share/tmp/OpC_appl/wasspi/oas/oas_set

Alternatively, you can use the -verbose option instead of the -silent option.

Use Policies/Tools to View Annotation Reports and Graphs

Some policies have actions defined with threshold violations or error conditions that
automatically cause reports to appear under the Annotations tab in the Message Properties
window. These reports are snapshots of data values collected form the server around the time
that the alarm occurred.

Other policies have operator actions associated with them that enable you to generate a
graph.

) The reports discussed in this section should not be confused with those generated by HP
Reporter, which show more consolidated, historical data generated as web pages in
management-ready presentation format.

You can access the data as follows:

e To view the Message Properties, double-click a message text in the HPOM message
browser. You can access Annotations by clicking the Annotations tab. Reports are available
there, showing data values on a single server.

e To view reports, follow these steps:
— From the HPOM console, select Integrations - HPOM for Unix Operational Ul.
— Select a node for which you want to generate a metric report.
— Right-click on the node.
— Select Start > SPI for Oracle AS - OASSPI Metrics > <Name of the Metric Report>.
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These reports show all server data on a node.
e To view graphs, follow these steps:
— From the HPOM console, select Integrations - HPOM for Unix Operational Ul.
— Select a node for which you want to generate a metric report.
— Right-click on the node.
— Select Start - SPI for Oracle AS > OASSPI Admin - View Graphs.

The web browser is launched, which opens the graphing feature available in HP
Performance Manager (which must be purchased separately).

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports are generated as soon as an
alarm is triggered in HPOM. Automatic Action reports show the state of the system moments
after the alarm occurred.

Viewing an Automatic Action Report

When an Automatic Action Report is run from HPOM, the server is queried for additional
data. If your message browser is set to display the SUTAONE columns, You will see an S
under the A column (see illustration), which indicates that a generated report is available
under the Annotations tab in the Message Properties window.

To view the report, double click the message text in the Message Browser and then click the
Annotations tab. Column descriptions provide further clarification.

Tool Bank Reports

You can use Tool Bank Reports to manually generate a report similar to an Automatic Action
report.

Tool Bank reports run for all Oracle OC4J/OHS server instances configured on the managed
node, in contrast to Automatic Action Reports which are generated for a single Oracle OC4dJ/
OHS server instance. The reports generated from the Tool Bank reflect the current state of
Oracle OC4J/OHS server on the managed node.
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Figure 16 OASSPI Reports
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e To generate a report in HPOM, follow these steps:

From the HPOM console, select Integrations - HPOM for Unix Operational Ul.

Select a node for which you want to generate a metric report.

Right-click on the node.

Select Start = SPI for Oracle AS - OASSPI Metrics > <Name of the Metric Report>.
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Sample Report

The following example shows the format of a Oracle AS SPI report. This report is
automatically generated (automatic action report) for metric C280.

Report Tor Application Server OC4J_SECURITY
Sep 29, 2005 5:23:49 PM
Metric C280_WebCntxTAVRQPrcC

web Context Request Active Service Threads Average Service Time (msec
Joc4j default,/WEEs /dms 1 .55

Joc4] /550/WEBS /fweb 0 1.93

web Context Session Active Sessions Total Active Time (msecs) Com|
Joc4j default,/WEEs /dms 0 0 0
Joc4] /550/WEBS /fweb 0 0 0

No data available Tor serwver HTTP_Server+appsrv.ovrsunrz.rose.hp.com.

Report Tor Application Server 0C4J_Portal
Sep 29, 2005 5:23:54 PM
Metric C280_WebCntxTAVRQPrcC

web Context Request

Active Service Threads Average sService

Joc4j /default/WEEs /dms

1 B.15
Joc4j /ultrasearchadmin/WEBs,admin 0 356.77
Joc4j /portal /wWEBs /portal 0 15.94
web Context Session Active Sessions Total Active Time (msel
Joc4j /default/WEEs /dms 0 0
Joc4j /ultrasearchadmin/WEBs,admin 2 179,932, 534
Joc4j /portal /wWEBs /portal 0 0
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Check the Oracle AS SPI Nodes for License Count

You can use an HPOM reporting utility to check the number of policies you installed on your
managed nodes. In reviewing the number of policies per managed node, you can see if you
consistently installed policies across your managed systems. In addition, by running this
report, you can also make sure that the number of licenses you purchased is in compliance
with the report results.

To run the report:

1 At the HPOM console, select the node or node group that you want to check.
2 From the Actions menu select Utilities = Reports....

3 In the Reports window, among the reports listed, select OASSPI License Check.
4  Select an output destination and click OK.
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5 Integrating HPOM Reporting and Graphing
Products with the Oracle AS SPI

The Oracle AS SPI can be integrated with the following HP reporting and graphing products.
These products must be purchased separately.

HP Reporter. Reporter produces management-ready, web page reports, showing
historical and trending information. This is not the version of Reporter that is included
with HP Operations Manager.

Working in conjunction with Reporter, the Oracle AS SPI produces a variety of reports
showing consolidated information on the Oracle Application Server.

For more information on how to integrate the Oracle AS SPI with HP Reporter, see
Integrating with HP Reporter on page 66. After integrating the Oracle AS SPI with
Reporter, every night, Reporter generates reports that show the performance and
availability of an Oracle Application Server on configured managed nodes.

HP Performance Agent. HP Performance Agent collects, summarizes, time stamps, and
detects alarm conditions on current and historical resource data across your system. It
provides performance, resource, and end-to-end transaction response time measurements,
and supports network and database measurement information. For more information
about HP Performance Agent, see the HP Performance Agent for UNIX User’s Manual.

HP Performance Manager. HP Performance Manager provides graphing capability of
the Oracle AS SPI metrics.

For more information on how to integrate the Oracle AS SPI with HP Performance
Manager, see Integrating with HP Performance Manager on page 68. After integrating
the Oracle AS SPI with HP Performance Manager, graphs are available the following day.

Integrating with CODA

The Oracle AS SPI can detect if you are using HP Performance Agent. If you are, the Oracle
AS SPI installation automatically uses it.

If you want to use the HP Operations subagent (CODA) included with OVO for UNIX 8.28,
8.29, and 8.30, you must configure the managed nodes to do so. Note that there are no
advantages to using CODA instead of HP Performance Agent.

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1

On the managed node, create a nocoda. opt file in the following directory:

Operating System File Location

HP-UX, Linux, Solaris | /var/opt/0OV/conf/dsi2ddf/

AIX /usr/lpp/0OV/conf/dsi2ddf/

Windows \usr\ov\conf\dsi2ddf\
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If the directory dsi2ddf does not exist, create it.

2 Save the empty file.

Integrating with HP Reporter

The Oracle AS SPI must be configured (see Chapter 3, Configuring the Oracle AS SPI) before
it can be integrated with Reporter.

The Oracle AS SPI report package must be installed on the Windows system running
Reporter:

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:

\WINDOWS\OV_REPORTER\ORACLEAS_SPNOASSPI-Reporter.msi
2 Follow the instructions as they appear.

3 Check the Reporter status pane (see the illustration that follows) to note changes to the
Reporter configuration.

) For Windows 2000 managed nodes, during the installation an error message might appear
that indicates the installer has detected an older version of the installer on your system. You
can safely ignore the message and continue.

The status pane (at the bottom of the Reporter window) shows you information on the
programs running and any errors occurring. You can check the status pane to see that
Reporter has been updated with the Oracle AS SPI reports.

You can find instructions in the Reporter Help for assigning the Oracle AS SPI reports to
the targeted nodes. To access Help, select Reports or Discovered Systems in the left panel
of the Reporter main window and right-click. Select Report Help or Discovered Systems
Help from the submenu that appears. See the topic “To assign a report definition to a
Discovered Systems Group.”

4  Add group and single system reports by assigning reports as desired. (See the Reporter
Help and the online Concepts Guide for complete information.)

) Group and single system Oracle AS SPI reports require that you identify systems by their full
name. For example, abc.xyz.comis acceptable while abc is not.

0 The browser crashes when the report is huge and the user hence is unable to view the report
(in HTML). The workaround is the reports should be viewed in pdf.

Oracle AS SPI Reports

The reports available through the integration of HP Reporter and the Oracle AS SPI show
consolidated data on server performance and availability on Oracle Application Server
systems. These reports are available the day following your installation of the Oracle AS SPI
report package on the Reporter Windows system. (See Integrating with HP Reporter on
page 66 if you did not complete the report package installation.)
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The tables that follow show all pre-defined reports for groups (one or more managed nodes on
which an Oracle Application Server is installed) and single systems.

Table 5 Group Reports
Oracle
AS
Title Description Version |Metric
Availability The percentage of up time of all Oracle |9.04, 2
Application Servers by day 10.1.2,
10.1.3
EJB Method Calls Process The number of all EJB method calls 9.04, 22
Rate - Top 20 processed per minute for the top 20 OC4J | 10.1.2,
servers 10.1.3
Servlet Active Threads - Top | The number of servlet active threads for | 9.04, 42
20 the top 20 OC4dJ servers 10.1.2,
10.1.3
Servlet Average Execution The servlet average execution time for 9.04, 240
Time - Top 20 the top 20 OC4dJ servers 10.1.2,
10.1.3
Table 6 Single System Reports
Oracle
AS
Title Description Version | Metric
HTTP Server and OC4J The percentage of hourly up time per day| 9.04, 2
Availability Details during the reporting period 10.1.2,
10.1.3
HTTP Server and OC4J The hourly average of the percentage of |9.04, 10,11
System Resource Utilization | CPU utilization and the percentage of 10.1.2,
system memory utilization per day 10.1.3
during the reporting period
HTTP Server Connections The average number of HTTP server 9.04, 100
connections per day for each application |10.1.2,
server on the selected system 10.1.3
DB Connection Cache The hourly average of the percentage of |9.04, 260
Utilization database connection cache utilization per| 10.1.2,
day during the reporting period 10.1.3
0C4J WebContext Sessions | The average number of WebContext 9.04, 281
sessions per day for each OC4dJ instance | 10.1.2,
10.1.3
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Integrating with HP Performance Manager

To integrate the Oracle AS SPI with HP Performance Manager, follow these steps:

1 Install and configure the Oracle AS SPI. Verify that you set the GRAPH_URL property.
For more information about the GRAPH_URL property, see Property Definitions on
page 130.

2 Ifyou are upgrading the Oracle AS SPI graph package, remove the old version before
installing the new version. For information on removing the Oracle AS SPI graph package
see To Install the New Graph Package (Optional).

3 Install the graph package.
On a Windows system running HP Performance Manager, follow these steps:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the
DVD-ROM drive, and in Windows Explorer, double-click:

\WINDOWS\OV_PM\ORACLEAS_SPNOASSPI-OVPM.msi
b  Follow the instructions as they appear.

On an HP-UX system running HP Performance Manager that is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are already installed using the swinstall

command):
a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:

swinstall -s <mount_point>/HPUX/
HP Operations_Smart Plug-ins_HPUX.depot OASSPI-GRAPHS

On a Solaris system running HP Performance Manager that is not the HPOM
management server, follow these steps (if HP Performance Manager is installed on the
HPOM management server, the files are already installed):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:

/usr/sbin/pkgadd -d <mount_point>/SOLARIS/
HP Operations_ Smart Plug-ins_SOLARIS.sparc HPOvSpiOasG

4  To graph any Oracle Application Server metric, use the data source name
OASSPI METRICS

See the HP Performance Manager documentation for information on how to view the graphs.
Graphs are available the day following integration.

Allow sufficient collection intervals to occur before attempting to view graphs (using HP
Performance Manager).

Data Source Description

Metrics collected by the Oracle AS SPI are stored in the data sources named
OASSPI_METRICS and OASSPI_RPT METRICS. The values can be viewed for trend analysis.

Class OASSPI_METRICS
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Column

Attribute

C005_JVMMEMUTILPCT

C010_CPUUTILPCT

C011_MEMORYUTILPCT

C012_CPUUTILPCTHTTP (for OAS version 10gR3 only)

C014_THREADPOOLUTIL (for OAS version 10gR3 only)

C015_THRDPOOLWAITCNT (for OAS version 10gR3 only)

C100_HTTPSVRACTCONN

C108_HTTPAVGRESPSZRQ

O | 0| | || | W DN

C109_HTTPVHAVRSPSZRQ

[y
o

C020_EJBCLACTTHREADS

11

C021_EJBCLAVGEXECTIM

12

C022_EJBCLCALLSPRCRT

13

C030_EJBWRAPACTTHRDS

14

C031_EJBWRPAVEXECTIM

15

C032_EJBWRPCALLPRCRT

16

J233_STLESSSNBNPLUTL (for OAS version 10gR3 only)

17

J234_STFULSSNBNPLUTL (for OAS version 10gR3 only)

18

J235_ENTITYBNPLUTL (for OAS version 10gR3 only)

19

C042_SRVLTACTTHREADS

20

C047_JSPACTREQUESTS

21

C050_JMSCONNCREATED

22

C280_WEBCNTXTAVRQPRC

23

C281_WEBCNTXTACTSESS

Class

Column

S O W N

OASSPI_RPT_METRICS

Attribute

METRICID
VALUE
SERVERNAME
OBJECTNAME
INSTALLATION
APPLICATION
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Viewing Graphs that Show Alarm Conditions

For graphing purposes, the Oracle AS SPI organizes metrics according to type. When a
message is generated for any metric (listed in Table 7 on page 70), you can view a chart of its
and other metric values.

To view a graph associated with an alarm condition (Operator-initiated action has been
defined with the Oracle AS SPI monitor policy), follow these steps:

1 In the HPOM Message Browser double-click the message.
2 In the Message Properties window, click Perform Action under the Actions tab.

The resulting action displays the metric’s Oracle AS SPI graph, which charts its values along
with the values of other metrics in the same group.

Viewing Graphs that Show Past/Current Conditions

You can also generate any of the graphs manually by using the View Graphs tool.
To manually generate a graph, follow these steps:

1 From the HPOM console, select Integrations - HPOM for Unix Operational Ul.

2 Select a node for which you want to generate a metric report.

3 Right-click on the node.

4 Select Start > SPI for Oracle AS > OASSPI Admin — View Graphs.

Oracle AS SPI Metrics Available for Graphs

The tables that follow show the graphs available for mapping collected metric values. If you
are interested in viewing any one of the metrics included in any of these tables, you can use
the View Graphs tool to launch the graph, which appears in your web browser.

Table 7 Metrics for Graphs

Oracle
AS
Title Description Version |Metric
JVM Memory Utilization JVM heap memory utilization 9.04, 5
10.1.2,
10.1.3
CPU and Memory Utilization | Percentage of server CPU time 9.04, 11
utilization and server memory size 10.1.2,
utilization 10.1.3
CPU Utilization Percentage of server CPU time 9.04, 10
utilization 10.1.2
HTTP Server Active Number of active connections to the 9.04, 100
Connections HTTP server 10.1.2,
10.1.3
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Table 7 Metrics for Graphs
Oracle
AS
Title Description Version | Metric
HTTP Server Response Data | HTTP server average response data size | 9.04, 108,
processed and HTTP server average 10.1.2, 109
response data size processed for the 10.1.3
virtual host
HTTP Server CPU Utilization| Percentage of the CPU time utilized by | 10.1.3 12
HTTP server over the collection interval
OC4J EJB Threads EJB method client and EJB method 9.04, 20, 30
wrappers active threads count 10.1.2,
10.1.3
0C4J EJB Execution Time Average execution time of the EJB 9.04, 21, 31
method client and EJB method wrappers| 10.1.2,
10.1.3
0OC4J EJB Calls Process Rate | EJB method client calls and EJB method | 9.04, 22,32
wrappers calls process rate for the 10.1.2,
interval 10.1.3
Servlet Threads Total number of threads servicing all 9.04, 42
servlets 10.1.2
JSP Requests Number of active JSP requests 9.04, 47
10.1.2,
10.1.3
JMS Metrics Number of JMX connections (local and | 9.04, 50, 51
remote) created by the JMS server during| 10.1.2,
the interval and number of messages in | 10.1.3
the destination store
JDBC Connection Pool Percentage of JDBC connection pool 9.04, 260
utilization 10.1.2,
10.1.3
0C4J Web Context Requests | OC4J web context average request 9.04, 280,
processing time and number of active 10.1.2, 281
sessions 10.1.3
Thread pool Utilization Percentage utilization of available 10.1.3 14
connections in thread pool
Thread pool Wait Count Number of task(s) waiting in the queue |10.1.3 15
for a thread to become available
Stateless Session Bean pool | Stateless Session Bean pool utilization | 10.1.3 233
Utilization
Stateful Session Bean pool Stateful Session Bean pool utilization 10.1.3 234
Utilization
Entity Bean pool Utilization | Entity Bean pool utilization 10.1.3 235
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Launching the Web Page Display with an Operator Action that Generates
Graphs

Performance Manager graphs can be generated from most Oracle AS SPI alarm messages by
pressing Perform Action from the message details, Properties, or the Message Browser. The
operator action launches your web browser, which displays a graph of the metric that
generated the message, as well as other related metrics.

Specifying a Date Range

Within the web page display, you can specify a date range of one day, one week, one month, or
one year. See the Online Help for instructions on changing display settings.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all
data for all instances are reported in one graph. The data for each SERVERNAME can also be
displayed in a separate graph.

This example also uses the Java interface option of HP Performance Manager.

1 Start the Java Interface option of HP Performance Manager. The Performance Manager
Java Interface window opens.

| Display | Design | :
O) New g3 Open... [ Save B Save As.. X Delete.. [3 Freview @ Help [ A
Genaral
Datasource: e i

Metrics |
Default Selection: |m|;.|;.1 SOUrCES

Mote: The default selection s onky used during araph design to previess the araph and retrieve metric W
information. Once you finish design and ssve the graph, you can then make multiple selections to

draw the graph. | T-Filter_|

[~ Complex Graph Design using multiple sources

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window, and then the Sources tab at the right of
the window.

b Click - | next to the Datasource text box and select a data source
(OASSPI_RPT_METRICS).
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¢ Click . | nextto the Default Selection text box and select the node on which the data

source resides.

3 Click the General tab at the right of the window.

 Display | Desion |

[ e 2 Open... Bl Save B Save As.. X Delete.. [§ Preview § Help (R0

(RN |

Subtitle: |
Type: table -
Description:
Date Range Poifits Every:
Duration: |3 [days =]  |5minutes -
Ending: ¢ Mow = Last Limit Murnber of Points to:
" Date: Time:
foui 26, 2004 f{oo: 00| =
Shift

[~ Owerride Shit Defaulls

Start [00: 00|=4 Stop : 594 r

Days ¥ Sun W i o F F = o
Metric Display Order:
" mverage data value
* Label (alphabetical)

At dmap M afead fama bl adsia s by

; General
Metrics
Sources

| chart |
Highlight
T-Filter

4 From this window,

a Select line from the Type drop-down list. This generates a line graph.

b Enter a Date Range.

¢ Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection

window opens.

o [# 0ASSPI_METRICS: OASSPI_METRICS

= [## 0ASSPI_RPT_METRICS:DASSPI_RPT_METRICS

=" [ mETRICID

=[] waLUE

-~ [| SERVERNAME

-~ [ oBJECTNAME

=7 [ INSTALLATION

“7 [ APPLICATION 1

Metric Selection | x|

Label: |
Type: Iline "I
Y Ais: IIEﬂ "I

Color: |:|Aut0 [ |

~Line Style

Stle: [soid <] Marker one | widin:p
“Fill Style

sie: fsois <]

Missing Data: Ihidden vl
Filter: | |
(] I Cancel | Help |

6 From the Metric Selection window,

a Next to the OASSPI RPT METRICS data source, click + to expand it in the tree.

b Select the VALUE check box.
¢ Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which
VALUE is displayed and click Properties. The Metric Properties window opens.

Metric Properties - OASSPI_RPT_METRICS:OASSPI_RPT_METRICS:V...
Label |[(@@SERVERNAME @@0BJECTHAME
Type: [lable =|
¥ s [left =]
Caolor I:l."«ml:l j

Line Siyle

sie: [roid =] Marker oot =] wiatnc |

Fill Stde

side: Jsolid ]
Wissing Data: [previous = | Sum [auto =]
Instance: | |
Filter: kSERVERNAME="@" &&0BJECTNAME= @ J

QI Cancel | Help |

8 From the Metric Properties window,
a In the Label text box, enter:

— QE@SERVERNAME : @ROBJECTNAME if you are creating one graph with all
SERVERNAMESs

— @QROBJECTNAME if you are creating one graph with one SERVERNAME
b In the Marker drop-down list, select any marker other than none.
¢ In the Missing Data drop-down list, select:
— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click - | next to the Filter text box. The Metric Filter window opens.
& Metric Filter
WETRICID = |z =] 1

0] 4 Cancel |

9  From the Metric Filter window,
a Select METRICID from the first drop-down list.
b  Select = from the second drop-down list (if it is not already selected).
¢ Enter a metric number (for example, 11) in the text box.
d Click OK.
10 From the Metric Properties window,

a In the Filter text box, append the following:
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— &&SERVERNAME=Q & &§OBJECTNAME=QQ if you want one graph to display all
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME="<server_ name>” &&OBJECTNAME=G if you want one graph to
display one SERVERNAME and all OBJECTNAMEs associated with the
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file.
For more information, see step step 13 on page 76.

b  Click OK.
1 Click Save As at the top of the window. The Save As window opens.

Save As X
Farmily: | j
Category: | j
Mame: | ﬂ

Help

12 From the Save As window,

a Enter a family (for example, OASSPI_Graphs) in the Family text box. The family
name serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name text box to uniquely identify the
graph.
¢ Entering text into the Category text box is optional.

d Click OK. The information is saved in a graph template file named
VPI GraphsUser<family>.txt (for example,
VPI GraphsUserOASSPI Graphs.txt).

For more information about this window, see the online help.

13 Edit the graph template file. The file is located in the HPOM data directory on the system
of the HP Performance Manager instance on which you are working. The graph file might
look similar to Figure 17.
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Figure 17
#*********************************************

#* OpenView Performance Manager
#* user Defined Graph Templates
#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] mool

#**********************************************

FAMILY: OASSPI_Graphs

GRAPH: Metricll
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: OASSPI_RPT_METRICS:0ASSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @QE@SERVERNAME :@@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_ 2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: OASSPI_RPT_METRICS:0ASSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11

LABEL: @QE@SERVERNAME :@QOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: to the end of the first section of each graph (in the example above,
add SUMFROMRAW: after SYSTEMNAME : mool). This enables HP Performance Manager
to summarized data from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter text box in the Metrics Properties window in step
step 10 on page 75, edit the FILTER field.

¢ Save the file. The graph file now contains the following (see Figure 18):
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Figure 18

#*********************************************

#* OpenView Performance Manager

#* user Defined Graph Templates

#* Last Updated: 07/25/05 04:31_30 AM by [1.2.3.4] mool
#**********************************************
FAMILY: OASSPI_Graphs

GRAPH: Metricll

GRAPHBACKGROUND: None

DATERANGE: 1 day

GRAPHMULTIPLEGRAPHS: Yes

POINTSEVERY: raw

DATASOURCE: mwa

SYSTEMNAME: mool

SUMFROMRAW :

CLASS: OASSPI_RPT_METRICS:0ASSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @E@SERVERNAME:@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool
SUMFROMRAW :

CLASS: OASSPI_RPT METRICS:0ASSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@EeOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:
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14 From the Performance Manager Java Interface window, click the Display tab.

| Display | Design |

Select one or more sources to see alist of avallable graphs,

Sources: |Indnidual Systems ~ Graphs:

= il -4il UserNick ]
& Al -Gl UserPauline
(- g HP-UX d *-gil UserPauline Test
=-5al OracieAS SPI
Add.. ] Clear | Fing.. J 4 Wetric11
] e . .ai MBMC""J
System Information -2 test -
Date Ranoe Points Every:
Duration: [1 lgays =] | [9minutes st
Ending: * MNow " Last [ Display graph in HTML

™ Date: Time:

l Edjoo: 005

Shitt
[~ Owerride Shit Defaults
=
Stan =] Stop :| r
Days [+ [+ o ¥ I+ = F

Logon Dirawy Help

15 In this window, follow these steps:

a In the window below the Sources text box, navigate to the server on which the data
source resides.

b In the Graphs window, navigate to the family of graphs and select the graph you
created.

¢ Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph opens.

) If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from
the graph template file. You must edit the graph template file and re-enter this
entry.

16 From the SPI, to enable graphing, follow these steps:
a From the HPOM console, select Integrations - HPOM for Unix Operational Ul.
b Select the node(s) which you want to enable for graphing.
¢ Right-click on the node(s).
d Select Start > JMX Metric Builder > OASSPI - UDM Graph Enable.
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6 Basic Troubleshooting and Error Messages

Selt-Healing Info Tool

The Self-Healing Info tool gathers SPI troubleshooting data and stores it in a file that you can
submit to HP support for assistance. For more information about this tool, see Self-Healing
Info on page 137.

) The file created by the Self-Healing Info tool might be hidden on some Windows managed
nodes. If you do not see the file, open Windows Explorer and, from the Tools menu, select
Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden files and
folders.



Logging

Management Server

The following log file is found on the management server (typically, /<%OQOuvInstallDir%>/ is

/var/opt/0V)
File Type Log
Filename /<%OvInstallDir%>/WASSPI/ocas/log/

<managed node> disc_ server.log

Description Records the updates done by the OASSPI Discovery policy to the
management server’s configuration for each managed node. Log files are
overwritten each time the discovery policy is run on the managed node.
Logging to this file is always enabled.

Managed Nodes

The following files for logging are found on the managed nodes running on UNIX or Windows
(typically, <Agent_Dir>/ is /var/opt/0V/ for UNIX and \Documents and Settings\All
Users\Application Data\HP\HP BTO Software\ for Windows):

Directory <Agent_Dir>/wasspi/oas/log/wasspi perl.log (archived files
have a one digit number appended to the filename)

Description File used by your HP support representative for debugging. This file
gives you information about the Perl logging (configuration, discovery,
and collection). By default, you can only view the error messages. To
view all types of messages (info, warn, and error), run the Start Tracing
tool. To stop the tracing, run the Stop Tracing tool. For more information
on how to run these tools, see Start/Stop Tracing on page 138. By
default, the log file size is 10MB and three archived versions are kept.

Directory <Agent_Dir>/wasspi/oas/log/Discovery.log (archived files
have a one digit number appended to the filename)

Description File used by your HP support representative for debugging. This file
gives you information about the Java discovery logging. By default,
you can only view the error messages. To view all types of messages
(info, warn, and error), run the Start Tracing tool. To stop the tracing,
run the Stop Tracing tool. For more information on how to run these
tools, see Start/Stop Tracing on page 138. By default, the log file size
is 10MB and three archived versions are kept.
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Directory

Description

Directory

Description

<Agent_Dir>/wasspi/oas/log/Collector.log (archived files
have a one digit number appended to the filename)

File used by your HP support representative for debugging. This file
gives you information about the Java Collector logging for the
CollectorServer. By default, you can only view the error messages. To
view all types of messages (info, warn, and error), run the Start
Tracing tool. To stop the tracing, run the Stop Tracing tool. For more
information on how to run these tools, see Start/Stop Tracing on
page 138. By default, the log file size is 10MB and three archived
versions are kept.

<Agent_Dir>/wasspi/oas/log/CollectorClient.log (archived
files have a one digit number appended to the filename)

File used by your HP support representative for debugging. This file
gives you information about the Java Collector logging for the
CollectorClient. By default, you can only view the error messages. To
view all types of messages (info, warn, and error), run the Start
Tracing tool. To stop the tracing, run the Stop Tracing tool. For more
information on how to run these tools, see Start/Stop Tracing on
page 138. By default, the log file size is 10MB and three archived
versions are kept.

Troubleshooting the Discovery Process

Problem: The OASSPI Service Discovery policy does not automatically discover and update
the Oracle AS SPI configuration.

Solutions:

1 Check for errors in the message browser of the managed nodes not being discovered.
Follow the instruction text of any error messages displayed.

2  Verify that an Oracle OC4J/OHS server is installed on the managed node. If an OC4dJ/
OHS server is not installed, install an OC4J/OHS server, and complete the configuration
tasks listed in Chapter 3, Configuring the Oracle AS SPI.

Verify the Oracle Application Server status. The application server must be running.

4 Verify the Java home directory (see Verifying the Java Home Directory on page 84).

Verify that the Discover or Configure OASSPI tool is not running. Only one process can
access the configuration at a time. If Discover or Configure OASSPI is running, other
processes that must access the configuration (like the discovery process) hang until the
configuration becomes available.

6 Check if the HPOM management server is suppressing duplicate messages:

a From the HPOM console, select Actions Server Configure. The Configure
Management Server window opens.

b Look for the “Suppress and count duplicate messages” check box. If this box is
selected, unselect it.
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7 Restart the HPOM management server:
a Stop all HPOM GUIs that are running by selecting File - Exit.

b Stop the HPOM management server processes. Enter:
/opt/OV/bin/ovstop opc ovoacomm

¢ Delete all HPOM temporary files. All pending messages (messages not saved in the
database) and all pending actions (automatic actions, operator-initiated actions,
scheduled actions, and command broadcast) are lost. Enter:
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*

d Restart the HPOM management server process. Enter:
/opt/0OV/bin/OpC/opcsv -start
/opt/OV/bin/OpC/opcsv -status

e Restart the HPOM GUI. Enter: opc

Problem: The OASSPI Service Discovery policy is adding inaccurate information to the
configuration.

Solutions:

1 Verify the Java home directory. For more information, see Verifying the Java Home
Directory on page 84.

2 Update the configuration.

Problem: The following error messages display when the Discover or Configure OASSPI tool
is run:

/usr/lib/dld.sl: Can’t find path for shared library: libiconv.sl
/usr/lib/dld.sl: No such file or directory
sh: 25691 Abort (coredump)

Solution:

Install the 1ibiconv. sl file on the HPOM management server. Download this file from:
http:/hpux.connectisl.com/hppd/hpux/Development/Libraries/

Problem: The service map is not getting displayed in the Operational Ul
Solution:

Type the following command to assign the services to the operator:
opcservice -assign <operator> <service>

For example: opcservice -assign opc_adm <service>

Veritying the Java Home Directory

To successfully use the OASSPI Service Discovery policy, the Java home directory (on both a
Windows and UNIX managed node) must be configured correctly.

Although the discover policy searches for this information, if it cannot find this information or
the information is not accurate, the discover policy does not function completely.

On each managed node on which you want to run the discover policy, verify one of the
following (listed in the order of precedence used by the discover policy):

e JAVA_HOME is correctly defined in the configuration. To edit or view the configuration,
run the Discover or Configure OASSPI tool:

a From the HPOM console, select Integrations = HPOM for Unix Operational Ul.
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e The

Select the node(s) on which you want to launch Discover or Configure OASSPI tool.
Right-click on the node(s).

Select Start = SPI for Oracle AS > OASSPI Admin — Discover or Configure OASSPI.
The Tool Selector window opens.

Click OK. By default, the Launch Configure Tool radio button is selected.

The Introduction window opens.

Click Next.

From the configuration editor, set the JAVA_HOME property. For more information
about using the configuration editor, see Using the Configuration Editor on page 119.

Click Save to save the changes made to the configuration. Once you save your changes,
you cannot automatically undo them.

Click Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Click OK.

If you click Cancel and made changes to the configuration, those changes remain
in the configuration on the management server. To make the changes to the
selected managed nodes’ configuration, you must select those nodes, start the
Discover or Configure OASSPI tool, launch the Discover tool, click Next from the
configuration editor, and then click OK.

Run discovery on the managed nodes on which the JAVA_HOME property was added
or edited. Running discovery updates the service map.

JAVA_HOME system variable is correctly defined.

On a Windows manage node, follow these steps:

a
b
c

d

e

Select Start — Settings = Control Panel.
Double-click System.

Click the Advanced tab.

Select Environment Variables...

Scroll through the System variables list. Verify the JAVA_HOME value. If
JAVA_HOME does not exist, it is not defined.

On a UNIX manage node, follow these steps:

a

b

Type echo $JAVA HOME
Verify the output. If no output is returned, JAVA_HOME is not defined.

Troubleshooting the Configuration

Problem: The OASSPI Service Discovery policy overwrites the configuration with inaccurate
information.

Solution: Update the configuration.
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Troubleshooting the Collection

e Problem: No alarms are received for a metric

Solution:

Verify that the monitor policy corresponding to the metric is deployed on the node.

Verify that alarm=yes is specified in the <Agent_Dir>/wasspi/oas/conf/
MetricDefinitions.xml file for the metric.

¢ Problem: On manually running the collector command on the managed node, the value of
the metric is printed as No instance,No data on STDOUT

Solution: Check the Admin Console for the presence of corresponding MBeans.

e Problem: Data is not getting logged

Solution:

Verify that the SPIDataCollector instrumentation category is deployed on the
managed node. This is required to create the datasource OASSPI_METRICS.

Verify that the OASSPI-Performance policy is deployed on the node.

Check if the <servername>.dat file is created in <Agent_Dir>/wasspi/oas/
dataloag.

Check if the datasource OASSPI_METRICS is created.

Verify that graph=yes is specified in the <Agent_Dir>/wasspi/oas/conf/
MetricDefinitions.xml for the metrics which are being monitored. Only the
metrics which are specified as graph=yes in the MetricDefinitions.xml get
logged. The default value is no.
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Troubleshooting the Tools

¢ Problem: Configuration variable SERVER<n> START CMD missing for server ‘Default
Server’

Solution: Before you can successfully run the Start Oracle AS tool, you must set the
START_CMD and USER properties. Set these properties using the Discover or Configure
OASSPI tool. For more information about this tool, see Discover or Configure OASSPI on
page 136.

e Problem: Configuration variable SERVER<n> STOP CMD missing for server "Default
Server"

Solution: Before you can successfully run the Stop Oracle AS tool, you must set the
STOP_CMD and USER properties. Set these properties using the Discover or Configure
OASSPI tool. For more information about this tool, see Discover or Configure OASSPI on
page 136.

e Problem: When launched, the Verify tool gives improper output.

Solution: Before you launch the Verify tool make sure that you have installed the latest
version of Self-Healing Service (SHS) component from the SPI DVD.

e Problem: When launched, the Self-Healing Info tool gives improper output.

Solution: Make sure that you have installed the latest version of Self-Healing Service
(SHS) component from the SPI DVD.

e Problem: When launching the tools, the tools hang or there is no output.

Solution: The tools will not work if the memory is low. Check the performance of the node
and the management server. The physical memory available must be more than 500 MB.

e Problem: View Status tool shows a wrong status for a server instance or does not give
any output.

Solution: If a server is up and running but View Status tool returns the server status as
NOT_RUNNING (or does not give any output), then turn ON the monitoring for that
particular server by using the Start Monitoring tool.

e Problem: Datasource not getting created on RHEL 4.0 platform.

Solution: Make sure that you have installed the latest version of DSI2DDF component
from the SPI DVD.
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Error Messages

This section provides detailed information on error messages resulting from conditions
detected in the operation of the Oracle AS SPI, not the Oracle Application Server itself. The
error messages discussed in this chapter, belong to the OASSPI Message Group.

For any given problem, only the most recent error message is displayed (the older error
message is automatically acknowledged). This reduces the number of error messages
displayed in the message browser.
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WASSPI-1

Description | Unable to create the lock file <filename>. File already exists.
Severity Critical
Help Text Probable Cause

Temporary lock files are used to avoid collisions if multiple Oracle AS SPI data collector
processes attempt to access the same data file. This error occurs when the lock file cannot be
created after several attempts because the file already exists.

Suggested Action

If a file by the same name already exists, it might not have been deleted by a previous run of
the Oracle AS SPI data collector. You should delete this file manually.

WASSPI-2

Description Cannot access the SPI configuration.
Severity Critical
Help Text Probable Cause

A Oracle AS SPI configuration file could not be located or accessed. Either the file does not
exist or there was a problem reading the file.

Suggested Action

1

Verify that the Oracle AS SPI has been configured correctly by running the OASSPI Admin
- Verify tool. If the configuration is not correct, run the OASSPI Admin —> Discover or
Configure OASSPI tool.

Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem, for example, an I/O exception. You can view the SPI
error log for a managed node by using the OASSPI Admin - View Error File tool. The error
message can be identified by the date/time stamp.

WASSPI-3

Description | Error parsing command line.
Severity Critical
Help Text Probable Cause

The Oracle AS SPI data collector command line is incorrectly specified in a collector policy.
Suggested Action

1

Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem, for example, an I/O exception. You can view the SPI
error log for a managed node by using the OASSPI Admin — View Error File tool. The error
message can be identified by the date/time stamp.

Correct the policy that contains the incorrect command line and redeploy. Refer to the HP
Operations Smart Plug-in for Oracle Application Server Configuration Guide for more
information on the Oracle AS SPI data collector command line.
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WASSPI-4

Description | Error getting the metric definitions.

Severity Critical

Help Text Probable Cause

The Oracle AS SPI data collector could not read the metric definitions XML document. This
error can be caused by a missing configuration property, an I/O error, an XML parsing error,
a missing file, or a corrupted serialized data file.

Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem, for example, an I/O exception. You can view the SPI
error log for a managed node by using the OASSPI Admin — View Error File tool. The error
message can be identified by the date/time stamp.

2 Ifthe UDM_DEFINITIONS_FILE property is missing from the OASSPI configuration
file, run the OASSPI Admin — Discover or Configure OASSPI tool and set the value for this
property.

3 Ifthe problem is with the metric definitions file (MetricDefinitions.xml) that is shipped
with the SPI for Oracle AS, then reinstall the SPI for Oracle AS. Run the OASSPI Admin —>
Discover or Configure OASSPI tool.

4 1If the problem is with a user-defined metric definitions file that is not shipped with the
SPI for Oracle AS, verify that this XML file adheres to the MetricDefinitions.dtd
specification. Refer to the HP Operations Smart Plug-in for Oracle Application Server
Configuration Guide for more information on writing user-defined metrics. Reinstall your
user-defined metric definition file. Run the OASSPI Admin - Discover or Configure OASSPI
tool and verify that the UDM_DEFINITIONS_FILE property in the SPI configuration, is
specified correctly.

5 If the underlying error is ClassNotFound, this is an internal error. Report this to HP
Support.

WASSPI-5

Description | Error processing metric <metric_number>.

Severity Major

Help Text Probable Cause
An error occurred while trying to collect data or perform calculations for the specified metric.
Suggested Action

Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem, for example, an I/O exception. The error messages previous
to this one provide more information about the problem. You can view the SPI error log for a
managed node by using the OASSPI Admin — View Error File tool. The error message can be
identified by the date/time stamp.
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WASSPI-6

Description | Required property <property_name> is missing from the Oracle AS SPI configuration.
Severity Major
Help Text Probable Cause

A required property is missing from the Oracle AS SPI configuration.
Suggested Action

1

Run the OASSPI Admin — Discover or Configure OASSPI tool. Verify that you have specified
the correct server information for the Oracle Application servers on this managed node.

Verify the property is specified correctly in the Oracle AS SPI configuration file (/
var/opt/0OV/wasspi/oas/conf/SiteConfig on UNIX platforms or
%0OvAgentDir%\wasspiloas\conf\SiteConfig on Windows platforms) on the
managed node in question.

WASSPI-7

Description | Unable to contact server <server_name> at url=<URL>, port=<port>.
Severity Critical
Help Text Probable Cause

The specified server is not running.

Suggested Action

1

Run the OASSPI Admin - Discover or Configure OASSPI tool. Verify that you have specified
the correct server information for the Oracle Application Servers on this managed node.
Verify that the properties, SERVERx_NAME and SERVERx_PORT are specified
correctly in the Oracle AS SPI configuration file (/var/opt/0V/wasspi/oas/conf/
SiteConfig on UNIX platforms or $0vAgentDir%\wasspi/oas/conf/SiteConfig
on Windows platforms) on the managed node in question.

Verify that the Oracle AS is running on the managed node.
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WASSPI-8

Description | Error saving graphing or reporting data to file <file_name>.
Severity Critical
Help Text Probable Cause

The specified graphing or reporting data file could not be found or an I/O error occurred
when trying to access the file.
Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

Identify the steps to reproduce the problem.

3 Run the OASSPI AdminOASSPI Admin — Start Tracing tool to turn on tracing. Try to
reproduce the problem.

4  Run the OASSPI Admin - Self-Healing Info tool. Contact HP support with the information
gathered by this tool.

WASSPI-9

Description | Unable to retrieve property <property_name>.
Severity Critical
Help Text Probable Cause

A required property is missing from one of the Oracle AS SPI configuration files.

Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin —> View Error File tool. The error message can be identified by
the date/time stamp.

2 Run the OASSPI Admin - Discover or Configure OASSPI tool. Verify that you have specified
the correct information for the Oracle Application Servers on the managed node in
question.

3 Verify that the missing property is now specified in the Oracle AS SPI configuration file (/
var/opt/OV/wasspi/oas/conf/SiteConfig on UNIX platforms or
$0vAgentDir%\wasspiloas\conf\SiteConfig on Windows platforms) on the
managed node in question.
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WASSPI-10

Description Encountered problem accessing file <filename>.
Severity Critical
Help Text Probable Cause

The specified file could not be found, created, or accessed. This file could be a temporary file.
Suggested Action

1

Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

Verify that you have enough disk space to create temporary files.

WASSPI-11

Description | No servers have been specified in the Oracle AS SPI configuration file.
Severity Major
Help Text Probable Cause

The number of Oracle Application Servers specified in the Oracle AS SPI configuration for
the managed node in question is 0.

Suggested Action

1

Run the OASSPI Admin - Discover or Configure OASSPI tool. Verify that you have specified
the correct server name and port information for the Oracle Application Servers on this
managed node.

Verify that the property, NUM_SERVERS, in the Oracle AS SPI configuration file
(/var/opt/0OV/wasspi/oas/conf/SiteConfig on UNIX platforms or
$0vAgentDir%\wasspiloas\conf\SiteConfig on Windows platforms) is set to the
number of Oracle Application Servers on this managed node.
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WASSPI-12

Description | Opcmon returned an error code of <error_number> for the command <opcmon_command>.
Severity Critical
Help Text Probable Cause

The opcmon process started by the Oracle AS SPI collector has returned an error (non-zero)
exit code.

Suggested Action

1 Identify the steps to reproduce the problem.

Run the OASSPI Admin - Start Tracing tool to turn on tracing.
Reproduce the problem.

Run the OASSPI Admin - Stop Tracing tool to turn off tracing.

Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.
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WASSPI-13

Description | Exception occurred while running an opcmon process.
Severity Critical
Help Text |Probable Cause

The Oracle AS SPI data collector attempted to run a process to start an opcmon call. Either
the process could not be created or was interrupted.

Suggested Action

For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are
set high enough to enable process creation.

WASSPI-14

Description Unable to find file <ﬁlename>.
Severity Critical
Help Text Probable Cause

A file required by the Oracle AS SPI data collector could not be found.

Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

2 Run the OASSPI Admin - Discover or Configure OASSPI tool on this managed node.
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WASSPI-15

Description Error parsing XML document <filename>.
Severity Critical
Help Text Probable Cause

An error occurred while parsing the specified XML document.
Suggested Action

1

Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

If the XML document was provided by the user, correct the document. Refer the HP
Operations Manager Smart Plug-in for Oracle Application Server Configuration Guide for
more information about the correct format for a user-defined metric definition document.
If the XML document is a document that is shipped with the Oracle AS SPI, run the

OASSPI Admin — Discover or Configure OASSPI tool to reinstall the Oracle AS SPI
configuration files.

WASSPI-16

Description | A bad filter <filter value> was specified for metric <metric_number>.
Severity Major
Help Text |Probable Cause

A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action

1

If the metric is specified in an XML document that was provided by the user, correct the
document. Refer the HP Operations Manager Smart Plug-in for Oracle Application Server
Configuration Guide for more information about the correct format for a user-defined
metric definition document.

If the metric is a pre-defined metric that is shipped with the Oracle AS SPI, run the
OASSPI Admin — Discover or Configure OASSPI tool to reinstall the Oracle AS SPI
configuration files.
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WASSPI-18

Description | Error logging to datasource <datasource_class_name>. Logging process returned exit code
<exit_code>.

Severity Critical

Help Text Probable Cause

The ddflog process started by the Oracle AS SPI data collector returned a non-zero error
code.

Suggested Action
1 Identify the steps to reproduce the problem.

2 Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

3 Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.

WASSPI-19

Description | Encountered problem instantiating XSLT transformer with <filename>.
Severity Major
Help Text Probable Cause

The XSL document that specifies the auto action report output contains errors.
Suggested Action
Run the OASSPI Admin — Discover or Configure OASSPI tool on the selected managed node.

WASSPI-20

Description | Encountered problem creating report for metric <metric_number>.
Severity Major
Help Text Probable Cause
An error occurred while producing a text report for the specified metric.
Suggested Action
Run the OASSPI Admin — Discover or Configure OASSPI tool on the selected managed node.
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WASSPI-21

Description | Encountered problem instantiating factory implementation.
'<class name>'.
Severity Critical
Help Text Probable Cause: The java property specifying the class name is incorrect or the class does

not implement the AppServerFactory interface.

Suggested Action: Verify that the java property appserver.implementation is set to the
fully qualified name of the class which implements the AppServerFactory interface.

WASSPI-23

Description Error initializing collector analyzer for server <server. name>.
Severity Critical
Help Text Probable Cause

An exception was encountered while preparing to monitor the specified server.
Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node
by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

Identify the steps to reproduce the problem.
3 Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

4  Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.

WASSPI-24

Description | Error logging in to server <server_name> with login <login>.
Severity Critical
Help Text Probable Cause

A security exception occurred while logging in to the specified server.
Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool on the managed node on which
the error occurred and verify that you have specified the correct login and password
properties.

2 Verify the login has appropriate permissions.
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WASSPI-26

Description The data logging process for <server_name> timed out.
Severity Major
Help Text Probable Cause

Depending on your configuration, either HP Performance Agent or CODA failed to exit
before the time-out.

Suggested Action
1 Restart CODA using the command opcagt -start.
2 Restart HP Performance Agent using the command mwa restart.

WASSPI-27

Description | RMI collector unable to process <command>.
Severity Warning
Help Text Probable Cause

An exception was encountered while performing an rmid related operation.

Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. You can view the OASSPI error log for a managed node

by using the OASSPI Admin — View Error File tool. The error message can be identified by
the date/time stamp.

Identify the steps to reproduce the problem.

3 Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

4 Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.

WASSPI-28

Description

RMID on port <port> has been <status>.

Severity

Normal

WASSPI-29

Description | Collector server <server id> for Java home <path> has been started.
Severity Normal
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WASSPI-30

Description | Failed to start <rmid path>on port <port>.
Severity Critical
Help Text Probable Cause

The specified port is already in use.
Suggested Action

1 Run the OASSPI Admin - Discover or Configure OASSPI tool. Set the RMID_PORT property
to a port number which is not currently in use.

WASSPI-31

Description

Lost connection to RMI collector while processing <command>.

Severity

Warning

WASSPI-32

Description

Unable to retrieve metadata for mbean <JMx-0ObjectName>.

Severity

Warning

WASSPI-33

Description | No actions matched server <server_name>, version <version>.
Severity Warning
Help Text Probable Cause

JMXAction element(s) define FromVersion and ToVersion tags which do not match the server
version.

Suggested Action

If the action is valid on the server, then either modify the JMXAction definition’s
FromVersion/ToVersion elements or modify the server’s VERSION property.
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WASSPI-34

Description | Metric <metric_id>does not define any actions.
Severity Warning
Help Text Probable Cause

The metric ID specified with the -m option does not define a JMXActions element.
Suggested Action

Correct the -m option if an incorrect metric ID was specified. Otherwise, add a JMXActions
definition to the metric definition.

WASSPI-35

Description | Error executing action <action command-1line>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while executing the action.
Suggested Action

View the managed node’s error log to determine the cause (follows the error message).

WASSPI-36

Description MBean <JMX_objectname> on server <server.name> does not expose operation
<operation name>.
Severity Warning
Help Text Probable Cause
An action’s JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action
Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

Description | MBean <JMx_objectname> on server <server_name> does not expose attribute
<attribute_name> for write.

Severity Warning

Help Text Probable Cause

An action’s JMXCalls element defines a write attribute exposed by the specified MBean as
read-only.

Suggested Action

If the specified MBean is a custom MBean, update its management interface so that the
attribute is writable. Otherwise, remove the attribute definition from the JMXCalls element.

WASSPI-38

Description

MBean <JMX_objectname> on server <server_name> does not expose attribute
<attribute_name>.

Severity

Warning

Help Text

Probable Cause

An action’s JMXCalls element defines an attribute not exposed by the specified MBean
ObjectName.

Suggested Action
Correct the JMXCalls element or remove the attribute from the element.

WASSPI-39

Description | Error invoking operation <operation_name>on MBean <JMX_ objectname>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while invoking an operation on the specified MBean. The
managed resource might have thrown an exception.

Suggested Action
View the managed node’s error log to determine the cause (follows the error message).
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WASSPI-40

Description | Error setting attribute <attribute name>on MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause

An unexpected error occurred while setting an attribute on the specified MBean. The
managed resource might have thrown an exception.

Suggested Action

View the managed node’s error log to determine the cause (follows the error message).

WASSPI-41

Description | Error getting attribute <attribute name> from MBean <JMX_objectname>.

Severity Major

Help Text Probable Cause

An unexpected error occurred while getting an attribute from the specified MBean. The
managed resource might have thrown an exception.

Suggested Action

View the managed node’s error log to determine the cause (follows the error message).

WASSPI-42

Description | Error running command <command>.

Severity Critical

Help Text Probable Cause

A command started by the Oracle AS SPI collector reported an error.
Suggested Action

1 Identify the steps to reproduce the problem.

Run the OASSPI Admin — Start Tracing tool to turn on tracing.
Reproduce the problem.

Run the OASSPI Admin — Stop Tracing tool to turn off tracing.

Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.
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WASSPI-43

Description | Error publishing event <event-type>.

Severity Major

Help Text Probable Cause
An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action

View the managed node’s error log to determine the cause (follows the error message).

WASSPI-201

Description | File <filename> not found.

Severity Critical

Help Text Probable Cause
A configuration file could not be found.
Suggested Action

Run the OASSPI Admin - Discover or Configure OASSPI tool. Verify that the correct
information has been specified for the Oracle Application Servers on the managed node on
which the error occurred.

WASSPI-202

Description | Cannot read file <filename>.

Severity Critical

Help Text Probable Cause

1 A file could not be opened or it could not be found.

2 Permissions might be incorrect or a directory might be corrupt.

Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool. Verify that the correct

information has been specified for the Oracle Application Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the HP Operations agent user to read this file.
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WASSPI-203

Description | Cannot write file <filename>.
Severity Critical
Help Text Probable Cause

Permissions might be incorrect, or a file or directory might be corrupt.
Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool. Verify that the correct
information has been specified for the Oracle Application Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the HP Operations agent user to write this file.

WASSPI-204

Description | Error sending opcmsg <message>.
Severity Critical
Help Text Probable Cause

There was a problem running opcmsg. “opcmsg” might be missing or not have permissions to
run (HPOM installation errors) or the system process table might be full.

Suggested Action
Confirm that the OASSPI-Messages policy has been deployed on the managed node.

WASSPI-205

Description | Error sending opcmon <command>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmon. “opcmon” might be missing or not have permissions to
run (HPOM installation errors) or the system process table might be full.
Suggested Action
Confirm that HPOM is properly installed and deployed to the managed node. Make sure that
the process table is not full. If it is, consider having the system administrator increase it.
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WASSPI-206

Description | Cannot read directory <directory>.
Severity Critical
Help Text Probable Cause

The permissions on the directory prevent the HP Operations agent user from reading it or
the directory is corrupt.

Suggested Action
Verify that the permissions are correct for the HP Operations agent user for this directory.

WASSPI-207

Description | Cannot move <filename> to <filename>.
Severity Critical
Help Text Probable Cause

1 Insufficient permissions.

2 Insufficient disk space.

3 File table problems.

Suggested Action

1 Verify that the permissions are correct for the HP Operations agent user.
2 Verify that there is enough disk space to create files.

3 Run the OASSPI Admin — Discover or Configure OASSPI tool.

WASSPI-208

Description OASSPI must be configured before it can be used.
Severity Critical
Help Text Probable Cause

The Oracle AS SPI has not been configured on this node.
Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool. Verify that the correct
information has been specified for the Oracle Application Servers on the managed node
on which the error occurred.

2 Run the OASSPI Admin — Verify tool on the managed node to confirm that the SPI has been
successfully configured.
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WASSPI-209

Description | Cannot contact Oracle Application Server.

Severity Critical

Help Text Probable Cause

1 The server could be down or not responding.

2 The Oracle AS SPI might be configured incorrectly.

Suggested Action

1 Verify that Oracle Application Server is up and running properly.
2 Run the OASSPI Admin — Discover or Configure OASSPI tool.

3 Run the OASSPI Admin — Verify tool on the managed node to confirm that the SPI has been
successfully configured.

WASSPI-210

Description | Cannot configure OASSPIL.

Severity Critical

Help Text Probable Cause
The Oracle AS SPI configuration process failed.
Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. The error messages previous to this one may also
provide more information about the problem. You can view the OASSPI error log for a
managed node by using the OASSPI Admin - View Error File tool. The error message can be
identified by the date/time stamp.

2 Run the OASSPI Admin — Discover or Configure OASSPI tool.

WASSPI-211

Description | Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause

There are insufficient permissions for the HP Operations agent user to create the directory
or there is insufficient disk space.

Suggested Action

Verify that the permissions are correct for the HP Operations agent user for this directory
and verify that there is enough disk space.
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WASSPI-213

Description Improper parameters to program <name>. Usage: <usage>.

Severity Critical

Help Text Probable Cause
The parameters to the program are incorrect.
Suggested Action

Correct the parameters.

WASSPI-214

Description Cannot run program <program_name>.

Severity Critical

Help Text Probable Cause

The program failed to run. It might be missing, permissions might be incorrect, or the
process table might be full.

Suggested Action

1 Verify that the file exists. If it is a Oracle AS SPI program and the file is missing, run the
OASSPI Admin — Discover or Configure OASSPI tool on the selected managed node.

2 Verify that the permissions are correct for the HP Operations agent user.

WASSPI-216

Description | Configuration variable <name> missing for server <server_name>.

Severity Critical

Help Text Probable Cause

A required Oracle AS SPI configuration property was not found.
Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool.

2 Verify that the correct information has been specified in the configuration for the
managed node on which the error occurred.
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WASSPI-218

Description | Oracle Application Server monitoring has been turned OFF for <server_name>.

Severity Warning

Help Text Probable Cause

Collection has been turned off for the specified server.

Suggested Action

If desired, collection can be turned on by running the OASSPI Admin — Start Monitoring tool.

WASSPI-219

Description | Oracle Application Server monitoring has been turned ON for <server_name>.

Severity Critical

Help Text Probable Cause

Collection has been turned on for the specified server.

Suggested Action

If desired, collection can be turned off by running the OASSPI Admin — Stop Monitoring tool.

WASSPI-221

Description | <filename> does not exist.

Severity Critical

Help Text |Probable Cause

The specified file does not exist. If it is a log file, no entries have ever been logged to it. If it is
a property file, then it has not been configured.

Suggested Actions

¢ Log files - If there have never been any entries written to the file, no action is necessary.
Otherwise, run the OASSPI Admin — Discover or Configure OASSPI tool.

¢ Property files - Run the OASSPI Admin — Discover or Configure OASSPI tool.
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WASSPI-222

Description | <filename> is empty.
Severity Critical
Help Text Probable Cause

The specified file is empty. If it is a log file, no entries have ever been logged to it, or the
entries have been cleaned out. If it is a property file, then it is not properly configured.

Suggested Action

If the file is a configuration file, run the OASSPI Admin —> Discover or Configure OASSPI tool.

WASSPI-223

Description | Cannot read <filename>.
Severity Critical
Help Text Probable Cause

1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool. Verify that the correct
information has been specified for the Oracle Application Servers on the managed node
on which the error occurred.

2 Verify that the permissions are correct for the HP Operations agent user to read this file.

WASSPI-224

Description ddfcomp returned an error configuring <name>.
Severity Critical
Help Text Probable Cause

ddfcomp returned an error. Neither HP Performance Agent nor CODA is installed on the
system or HP Performance Agent or CODA is not configured correctly.

Suggested Action
1 If the performance agent is not installed, this error can be ignored.
2 Otherwise. identify the steps to reproduce the problem.

3 Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

4 Run the OASSPI Admin — Self-Healing Info tool. Contact HP support with the information
gathered by this tool.
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WASSPI-225

Description | No logfiles were found. Did you run OASSPI Config?
Severity Critical
Help Text Probable Cause

The logfile list is empty.
Suggested Action

Run the OASSPI Admin — Discover or Configure OASSPI tool.

WASSPI-226

Description | Cannot read file <filename>.
Severity Critical
Help Text |Probable Cause

1 A file could not be opened or it could not be found.

2 Permissions might be incorrect or a directory might be corrupt.

Suggested Action

1 Run the OASSPI Admin — Discover or Configure OASSPI tool.

2 Verify that you specified the correct information for the Oracle Application Servers on the

managed node on which the error occurred.

3 Verify that the permissions are correct for the HP Operations agent user to read this file.

WASSPI-227

Description | No HP performance agent is installed. Data source will not be configured.

Severity Warning

Help Text Probable Cause:
If an HPOM is available, the SPI integrates with it. This warning indicates that none is
available.
Suggested Action:
If you must have a performance agent installed, verify that it is installed correctly and is
running; reinstall it if necessary. Otherwise, this message can be ignored.
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WASSPI-228

Description | ddflog returned an error logging <logfile-name>: <system-error-msg>
Severity Warning
Help Text Probable Cause

An error was returned by ddflog. This error could have been caused by the Oracle AS SPI not
being properly configured to support logging performance data.

Suggested Action

1 Redeploy SPI for Oracle Application Server and SPI Data Collector instrumentation on
the node having the problem.
Otherwise, examine the system error message, if any, for clues to the problem.

3 Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

4  Run the OASSPI Admin - Self-Healing Info tool. Contact HP support with the information
gathered by this tool.

WASSPI-229

Description Cannot connect to directory <directory_name>
Severity Warning
Help Text Probable Cause

The directory does not exist or the user the agent is running under does not have appropriate
permissions to the directory.

Suggested Action
Run the OASSPI Admin - Discover or Configure OASSPI tool.

WASSPI-230

Description | Cannot get lock <file> after <time>
Severity Critical
Help Text Probable Cause

A Oracle AS SPI process is hung or taking longer than expected. This could be due to a very
slow running or hung SPI process. Possibly a SPI process that had a lock was killed before
the lock it had open had been cleared.

Suggested Action
Make sure no SPI processes are running. Manually remove the lock file.
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WASSPI-23]

Description | Error starting JRE <JVM_file>: <message>
Severity Critical
Help Text Probable Cause: Some error occurred starting Java. This could be that the specified JVM

does not exist, has bad permissions, or that there are system resource limitations such as
process table entries or memory, or that the JAVA_HOME variable in the SPI SiteConfig file
is not set correctly.

Suggested Action:

Check for other errors generated at the same time, they may indicate the real cause. If the
specified file does not exist, check your JAVA_HOME or HOME variables in the SPI
configuration.

WASSPI-232

Description | Server <name> specified on command line, but not in configuration.
Severity Critical
Help Text Probable Cause

There was a -1 or —e specified on the collector command line which specified a server name
that was not listed in the SPI configuration. The collector only knows about servers listed in
the configuration.

Suggested Action:
1 Specify a correct server name on the command line.
2 Run the OASSPI Admin — Discover or Configure OASSPI tool.

3 Verify the Oracle AS names are correctly listed and spelled in the SPI configuration. Note
that the server name is case-sensitive.

WASSPI-234

Description

Error running program <file>, return value: <n>.

Severity

Critical

Help Text

Probable Cause

The SPI attempted to run the specified tool or auxiliary program and encountered an error
(the return code is specified).

Suggested Action

If the tool is a SPI tool, make sure the SPI has been installed and configured correctly. If not,
reinstall or reconfigure. If it is a system tool, make sure there are no system problems that
prevent the tool from running.

112

Chapfer 6



WASSPI-235

Description | Restart of HP Performance agent failed.
Severity Warning
Help Text Probable Cause

The SPI attempted to automatically restart the HP Performance agent and the automatic
attempt failed.

Suggested Action

Restart the HP Performance agent manually using the command mwa restart server.

WASSPI-236

Description | Failure when running XSLT on <xml> with stylesheet <xsl>:<message>.
Severity Critical
Help Text Probable Cause

As part of setting up graphing for user defined metrics, a translation of the UDM XML is
done. This message indicated that the translation failed for some reason.

Suggested Action

Review the message shown. It is most likely that there is an error in the XML.

WASSPI-237

Description | This is an informational message that an HP Performance Manager or HP Performance
Agent datasource was set up.
Severity Normal

WASSPI-241

Description | Cannot delete file <file>.
Severity Critical
Help Text Probable Cause

The SPI failed to delete the specified file. It might be that the protection of the file is set so
that the HP Operations agent user cannot delete it, or that there is some system problem
preventing the file from being deleted.

Suggested Action
Make sure the protection of the file is correct.
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All Other Errors

Description | An unknown error appears in the Oracle AS SPI error log.

Severity Major

Help Text Suggested Action

1 Refer to the text following the error message in the OASSPI error log to help identify the
underlying cause of the problem. The error messages previous to this one may also
provide more information about the problem. You can view the OASSPI error log for a
managed node by using the OASSPI Admin — View Error File tool. The error message can be
identified by the date/time stamp.

Identify the steps to reproduce the problem.

Run the OASSPI Admin — Start Tracing tool to turn on tracing. Try to reproduce the
problem.

4  Run the OASSPI Admin - Self-Healing Info tool. Contact HP support with the information
gathered by this tool.
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A File Locations

You can find the Oracle AS SPI configuration files and error logs in specific directories.

HPOM Management Server File Locations

Operating System | File File Location
HP-UX Configuration /opt/OV/wasspi/oas/conf
Solaris Configuration /opt/OV/wasspi/oas/conf

Managed Node File Locations

These file locations are valid if you are migrating the UNIX or Windows node, on which
WebSphere SPI is running, to non-root HTTPS agent environment. (UNIX only: if these
directories do not exist, see the table in Non-Root HTTPS Agent Environment on page 116 for
file locations):

Operating System | File File Location

HP-UX, Solaris, Linux| Configuration| /var/opt/0OV/wasspi/oas/conf

HP-UX, Solaris, Linux| Error Logs /var/opt/OV/wasspi/oas/log

AIX Configuration| /var/opt/0V/wasspi/oas/conf

AIX Error Logs /var/opt/OV/wasspi/oas/log
Windows (HTTPS) Configuration| \Documents and Settings\All
Users\Application Data\HP\HP BTO
Software\wasspiloas\conf

Windows (HTTPS) Error Logs | \Documents and Settings\All
Users\Application Data\HP\HP BTO
Software\wasspiloas\log
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Non-Root HTTPS Agent Environment

On newly configured the Oracle AS SPI managed nodes in the non-root HT'TPS agent
environment (UNIX only):

Operating System | File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/0OV/conf/ocasspi
HP-UX, Solaris, Linux | Error Logs /var/opt/OV/log/oasspi
AIX Configuration | /var/opt/0OV/conf/ocasspi
AIX Error Logs /var/opt/OV/log/oasspi
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B The Configuration

This appendix explains how to use the configuration editor, describes of the configuration
properties, and provides samples of the configuration.

Structure

See Sample Configurations for the Oracle AS SPI on page 133 for examples of the

configuration. The basic structure of the configuration is (lines preceded by # are treated as
comments and are ignored):

# Global Properties
property=<value> ...

# GROUP Block
GROUP <group name>
{

<node name> ...

}

# NODE Block

NODE <node name | group name>
{

property=<value> ...

}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can

be overridden by properties set within a GROUP or NODE block or by server-specific
properties.

GROUP Block

# GROUP Block
GROUP <group name>
{

<node name> ...

}
GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block
<group_name> is repeated within the configuration, the last definition takes precedence.

<node name> lists the nodes in the group and is the primary node name configured in HPOM.
The node name specified in a GROUP block matches the value returned by the HPOM
variable SOPC_NODES, which is the primary node name configured in HPOM.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the
Default Properties item in the <Group Name> folder.

NODE Block

# NODE Block
NODE <node name | group name>

{

<property>=<value> ...

}

Properties set in a NODE block apply to nodes belonging to the group defined by
<group name> (to set common properties for a group) or to the specified <node name> (to set
properties for a single node).

For a group, enter the <group name> defined by the GROUP block and define the group’s
common properties.

For a single node, enter the <node name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the
Default Properties item in the <Node Name> folder.

Server-Specific Properties

Each property specified as SERVER<n> property refers to a specific Oracle OC4J/OHS server
instance. When more than one Oracle OC4J/OHS server instance is running on a given
managed node, the number <n> differentiates the servers. Numbering begins at “1” and each
Oracle OC4J/OHS server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:
1 SERVER<n> property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 <property> (global property)
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Using the Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the
configuration using this editor only.

The main features of the configuration editor are:
e Tree
e Buttons

e Actions

Configuration Editor — Tree

The Configuration Editor tree, displayed in the left pane of the Discover or Configure OASSPI
tool’s main window, displays the Oracle AS SPI configuration in a tree structure.

The following is an example of the tree.

) If no OC4J/OHS servers or groups are configured, the “OC4J/OHS Servers” and “Groups”
folders are not displayed. If you are running the Discover or Configure OASSPI tool for the
first time and you did not select any nodes before you launched the tool, the “Nodes” folder is
not listed.

=F ] Configuration
=k 7 Defaults
I— Default Properties
=k 2 OCATIOHS Servers
|— <App_Serverl_Name:
=F 7 Groups
.:l- 7 <Group_Mame:
I— Default Properties
=F ] OC4TioHS Servers
|— <App_Server?_Name:
=F ] Nodes
=k 7 <Mode_Name>
I— Default Properties
=F ] OC4TioHS Servers
|— <App_Server3_Name:

The icons are defined as follows:

| The configuration properties can be viewed.
The configuration properties can be viewed and set.

The Configuration 119



120

The following table lists each item in the tree and a brief description of the item.

Item Name

Description

OC4J/OHS Servers

A folder that contains a list of all the OC4J/OHS servers. This
folder can appear under Defaults (global properties),
Group_Name(s) (GROUP block), or Node_Name(s) (NODE
block).

<0C4J/OHS_Server_Name>

The name of the OC4J/OHS server.

Configuration

A folder that contains all the Oracle AS SPI configuration
information for the Oracle Application Server environment.

Default Properties

Lists the configuration properties that are set. This item
appears under Defaults (global properties), Group_Name(s)
(GROUP block), or Node_Name(s) (NODE block).

Defaults

A folder that represents the global properties. Default
properties set at this level apply to all nodes. However, these
properties can be overridden by properties set under the
Group_Name and Node_Name folders (for more information,
see Property Precedence on page 118).

Groups

A folder that represents the GROUP block.

<Group_Name>

A folder that identifies the name of a group of nodes with
common properties. Default properties set at this level apply to
all nodes that belong to the specified group. These properties
can be overridden by properties set under the Node_Name
folders (for more information, see Property Precedence on
page 118).

Nodes

A folder that represents the NODE block.

<Node_Name>

A folder that represents a single node whose name matches the
value returned by the HPOM variable $OPC_NODES, which is
the primary node name configured in HPOM. Default
properties set at this level apply to the specified node only (for
more information, see Property Precedence on page 118).
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Configuration Editor — Buttons

The following buttons are available in Discover or Configure OASSPI- Configuration Editor

window:

Button

Description

Cancel

Exit Discover or Configure OASSPI.

If you set configuration properties without saving them, these changes
are not saved.

If you added or removed an OC4J/OHS server, node, or group without
saving the change or if you modified a configuration property, a Confirm
Cancel window opens. Click Save and Exit to save the changes before
exiting, Exit without Save to exit without saving the changes, or Return to
Editing to continue editing the configuration (changes are not saved).

Finish

Exit Discover or Configure OASSPI. Appears instead of Next if you
launched Discover or Configure OASSPI without selecting any nodes.

Next

Exit Discover or Configure OASSPI. Takes you to the “Confirm
Operation” window that lists the nodes you selected before you started
Discover or Configure OASSPI. The selected managed nodes’
configurations are updated with your changes. If you made changes to
nodes that were not selected (are not displayed in the “Confirm
Operation” window), the changes are saved to the HPOM management
server’s configuration, but to make the changes to those managed
node’s configuration, you must select those managed nodes from the
node bank, restart Discover or Configure OASSPI, and then exit.

Save

Save changes to the HPOM management server’s configuration and
continue editing the configuration. You can also select File — Save to
save your changes.

Configuration Editor — Actions

Actions that you can perform depend upon the item that is selected in the tree and from where
you access the action. The following actions can be accessed from the Actions menu, File
menu, or by right-clicking on an item in the tree.

Action

Description Selected Tree Item

Add OC4J/OHS Server Add an OC4J/OHS server. For more | :30C4J/OHS Servers

information, see Add OC4J/OHS “Defaults

Server on page 123. S<Group _Name>

O<Node_Name>

Add Group

Create a group to which you can z3Any item in the tree
assign nodes that have common Any item in the tree

properties. For more information,
see Add Group on page 123.

Add Node

Add a managed node to the Nodes z3Any item in the tree
folder. For more information, see Any item in the tree
Add Node on page 124.

The Configuration
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Action

Description

Selected Tree Item

Exit

Exit the Discover or Configure
OASSPI tool. This action is available
from the File menu. If any changes
were made that have not been saved,
the Confirm Cancel window opens.

3Any item in the tree
Any item in the tree

Remove OC4J/OHS
Server/Remove ALL
OC4J/OHS Servers

Remove an OC4J/OHS server or all
listed OC4J/OHS servers. For more
information, see Remove OC4J/OHS
Server/Remove ALL OC4J/OHS
Servers on page 124.

30C4J/OHS Servers

<0C4J/
OHS_Server_Name>

Remove Group/Remove
ALL Groups

Remove a Oracle AS SPI group or all
listed Oracle AS SPI groups. For
more information, see Remove
Group/Remove ALL Groups on

page 125.

=31 Groups
O<Group_Name>

Remove Node/Remove

Remove a managed node or remove

=1Nodes

ALL Nodes all managed nodes. For more “A<Node Name>
information, see Remove Node/ -
Remove ALL Nodes on page 126.

Save Save changes to the configuration. | 3Any item in the tree

This action is available from the File
menu only if changes were made to
the configuration.

Any item in the tree

Set Configuration
Properties tab

Set the Oracle AS SPI configuration
properties. For more information,
see Set Configuration Settings Tab
on page 126.

<0C4J/
OHS_Server_Name>

Default Properties

View Configuration
Settings tab

View the Oracle AS SPI
configuration properties. For more
information, see View Configuration
Settings Tab on page 126.

1Any item in the tree
Any item in the tree

Add OC4J/OHS Server

Add an Oracle OC4J/OHS Server instance at the global properties, GROUP, or NODE level in

the Oracle AS SPI configuration.
To add an OC4J/OHS server, follow these steps:

1 Right-click one of the following items in the tree: Defaults (global properties level), OC4dJ/
OHS Servers (global properties level), <Group_Name> (GROUP level), or <Node_Name>

(NODE level) and select Add OC4J/OHS Server.
The Configure OASSPI Tool: Add OC4J/OHS Server window opens.

2 Enter the “OC4J/OHS Server Name.” This is the name of the OC4J/OHS server as defined

in the Oracle Application Server and is case-sensitive. The Oracle Application Server
Control Console displays the server names of all configured OC4J/OHS servers in a
domain. Use these names for the OC4J/OHS Server Name.

3 Click OK.
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The NAME property is set.

The OC4J/OHS server is added and its properties are displayed. You can also set
additional configuration properties for this server. For more information, see Set
Configuration Settings Tab on page 126.

4 Click Save to save your changes.
If you do not want to add this OC4J/OHS server, right-click the OC4J/OHS server name,
select Remove OC4J/OHS Server, and click Save.
Add Group

Assign nodes to a group that have common properties in the Oracle AS SPI configuration.

To add a group, follow these steps:

1

Right-click any item in the tree and select Add Group.
The Configure OASSPI Tool: Add Group window opens.

2 Enter the Group Name. The group name identifies the group of nodes with common
properties and is not case-sensitive.

3 Click OK.
The group is added and the Set Configuration Properties tab for the group is selected.

4  Select Add Node to Group, select one node from the list to add to the group, and click OK.
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set pulldown
list. For more information, see Set Configuration Settings Tab on page 126.

6 Click Save to save your changes.
If you do not want to add the group, right-click the group name, select Remove Group, and
click Save.

Add Node

The Configuration

Add a managed node to the Oracle AS SPI configuration.

To add a node, follow these steps:

1

Right-click any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the following
message appears:

All available managed nodes have been added to the configuration.
Click OK to exit this action.

Otherwise, the Configure OASSPI Tool: Add Node window opens.

From the pulldown menu, select a node to add.

Click OK.

The node is added and the Set Configuration Properties tab for the node displays.

Set the configuration properties for this node using the Select a Property to Set drop-down
list. For more information, see Set Configuration Settings Tab on page 126.

Click Save to save your changes.
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If you do not want to add the node, right-click the node name, select Remove Node, and
click Save.

Remove OC4J/OHS Server/Remove ALL OC4J/OHS Servers

Remove an OC4J/OHS Server or all listed OC4J/OHS Servers from the Oracle AS SPI
configuration.

To remove an OC4J/OHS server, follow these steps:
1 Right-click the OC4J/OHS server name and select Remove OC4J/OHS Server.

The selected OC4J/OHS server name is removed from the list and its configuration
properties are removed from the configuration.

2 Click Save to permanently remove the OC4J/OHS server.

Click Cancel to cancel the removal of the OC4J/OHS server (the OC4J/OHS server name
appears the next time you run Discover or Configure OASSPI). In the Confirm Cancel
window, click Exit without Save.

To remove ALL OC4J/OHS servers, follow these steps:
1 Right-click the OC4J/OHS Servers folder and select Remove ALL OC4J/OHS Servers.

The selected OC4J/OHS Servers folder and all OC4J/OHS servers listed in the selected
folder are removed (all configuration properties for the listed OC4J/OHS servers are
removed from the configuration).

2 Click Save to permanently remove the OC4J/OHS servers.

Click Cancel to cancel the removal of all OC4J/OHS servers (the OC4J/OHS Servers folder
and all OC4J/OHS server names listed in the folder appear the next time you run
Discover or Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

Remove Group/Remove ALL Groups

Remove a Oracle AS SPI group or all listed Oracle AS SPI groups from the Oracle AS SPI
configuration.

To remove a group, follow these steps:
1 Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed
from the configuration.

2 Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you
run Discover or Configure OASSPI). In the Confirm Cancel window, click Exit without Save.
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Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the Oracle AS SPI configuration.
To remove a node, follow these steps:
1 Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed
from the configuration.

2  Click Save to permanently remove the node.

Click Cancel to cancel the removal of the node (the node name appears the next time you
run Discover or Configure OASSPI). In the Confirm Cancel window, click Exit without Save.

To remove ALL nodes, follow these steps:
1 Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all
configuration properties for the listed nodes are removed from the configuration).

2 Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed
in the folder appear the next time you run Discover or Configure OASSPI). In the Confirm
Cancel window, click Exit without Save.

Set Configuration Settings Tab

The Configuration

Set the Oracle AS SPI configuration properties at the global properties level or for the
selected OC4J/OHS server(s), group(s) (GROUP level), or node(s) (NODE level).

Items with the & icon are the only items for which you can set configuration properties
(Default Properties and <OC4.JJ/ OHS_Server_Name>).

To set the configuration properties of an item, select the item and click the Set Configuration

Properties tab in the right pane.

Setting a Property

To set a property in the configuration, follow these steps:

1 Select a property from the Select a Property to Set pulldown menu.

Select Set Property. The property and an empty value filed appear in the table.
Click the empty value field and enter a value.

Repeat steps 1 through 3 for each property to set.

Click Save.

O A W N

Modifying a Property

To modify a property in the configuration, follow these steps:
1 Select the property from the table.

2 Double-click the value field.

3 Edit the value.

4  Repeat steps 1 through 3 for each property to modify.
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5 Click Save.

Removing a Property

To remove a property from the configuration, follow these steps:

1 Select the property from the table.

2 Click Remove Property.

3 Repeat steps 1 and 2 for each property to remove.

4 Click Save.

For more information about individual properties, see Configuration Properties on page 128.

View Configuration Settings Tab

The options under this tab enable you to view all the Oracle AS SPI configuration properties
set in the configuration on the HPOM management server or the Oracle AS SPI configuration
properties for the selected OC4J/OHS server(s), group(s), or node(s).

To view the configuration properties of an item, select the item and click the View Configuration

Settings tab in the right pane.

The following table describes the view when the specified item is selected.

Item Name

Description of View

OC4J/OHS Servers

View all configuration properties set for all the listed
0OC4J/OHS servers.

<0C4J/OHS_Server_Name>

View all configuration properties set for the OC4J/OHS
server (these properties can be modified by selecting the
Set Configuration Properties tab).

Configurations View all configuration properties saved in the
configuration on the HPOM management server.

Default Properties View all configuration properties that are set (these
properties can be modified by selecting the Set
Configuration Properties tab).

Defaults View all configuration properties set at the global
properties level.

Groups View all configuration properties set for all the listed

groups.

<Group_Name>

View all configuration properties set for the specific
group.

Nodes

View all configuration properties set for the listed
nodes.

<Node_Name>

View all configuration properties set for the specific
node.
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View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting
this check box, the view of the configuration properties changes to show all inherited
properties (those properties defined at a global properties level or GROUP level) that affect
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By clearing this check box, the view shows only the configuration properties set at that level
for the selected item.

You can modify the inherited properties at the level they are set. If “<*>” appears after the
property, the property cannot be modified at that level. For example, if the property HOME is
set at the global properties level (under the Defaults folder), it can only be modified in the
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after
it) in a <Group_Name>’s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree.
For example, if the property HOME is set at the global properties level (under the Defaults
folder) and the property HOME is set at the GROUP level, the GROUP level property value
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest:
1 Server-specific

2 NODE level

3 GROUP level

4  Global properties level

Configuration Properties

Table 8 on page 129 lists all properties by the Oracle AS SPI requirements:

Property Name of the property.

Requirements Lists the property requirements for specific components:

R - Required: The property must be set.

C- Conditional: The property might need to be set if certain
conditions are met.

O - Optional: The property is not required for the
component to work.

blank - Not Applicable: The property does not affect this
component.

Oracle AS SPI Configuration requirements for the Oracle AS SPI to work.

Discovery Requirements for the discover process to work.
Process

Auto-Discovered The property is automatically set by the discover process.
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Level of The level at which this property can be set within the configuration
Configuration structure.

Default The global, group, or node level within the configuration structure.
Properties
Application The server-specific level within the configuration structure.
Server
Table 8 Properties Listed by the Oracle AS SPI Requirements
Requirements Level of Configuration
Oracle |Discovery |Auto- Default Application
Property AS SPI |Process |Discovered |Properties Server
HOME R R v v v
HOME_LIST R R v v v
JAVA_HOME R R v v v
LOGIN R R v v
MAP_KEY_PREFIX R R v v
NAME R v
PASSWORD R R v
URL_PATH R R v v
ALIAS C v
GRAPH_URL C v
RMID_PORT C v
RMID_START TIME C v
START_CMD C v v
STOP_CMD C v v
TYPE C v v
USER C v v
VERSION C v v
TIMEOUT o v v
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Property Definitions

Table 9 Configuration Properties
Required/
Applicable |Conditional/
Property OAS Version|Optional Description
ALIAS 9.04, Conditional ALIAS is a unique name assigned to an OC4dJ/
10.1.2, 10.1.3 |Required if more |OHS server on a managed node if more than
than one OC4J/ |one OC4J/OHS server on the managed node
OHS server on a |share the same server name. The alias, if set, is
system share the |[the name used in messages, reports, and
same server graphs (otherwise, SERVER <n>NAME is
name. used).
If ALIAS is modified, the data for the old alias
is saved but not mapped to the new alias.
Example: NODE petstore.hp.com
{SERVER1 NAME=dog
SERVER1 ALIAS=beagle
SERVERZ NAME=dog
SERVERZ2 ALIAS=dachshund
}
NODE flying ace.hp.com ({
SERVER1 NAME=snoopy
SERVER1 ALIAS=beagle
SERVERZ NAME=snoopy
SERVERZ2 ALIAS=red baron
}
GRAPH_URL 9.04, Conditional The fully-qualified URL used to launch HP
10.1.2,10.1.3 |Required if you Performance Manager. Set at the global level
want to use the |only.
View Graphs tool |[Examples: GRAPH URL = http://
(HP Performance |<server name>:<port no>/OVPM(HP PM 8.20
Manager must be |on Windows and UNIX), the default port
installed). number is 8081
HOME 9.04, Required The directory where the Oracle Application
10.1.2,10.1.3 Server is installed.
Example:
HOME = /opt/oracle/infra
HOME_LIST 9.04, Required The directory which contains all the locations
10.1.2,10.1.3 for HOME separated by ;.
JAVA_HOME 9.04, Required The directory where Java is installed that is
10.1.2, 10.1.3 |Required by the |used by the collector. The java engine is

discovery process
if there is more
than one
directory where
Java is installed.

expected to be $JAVA HOME/bin/java.
Example: JAVA HOME = /opt/oracle/jdk

The Configuration
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Table 9

Configuration Properties

Property

Applicable
OAS Version

Required/
Conditional/
Optional

Description

LOGIN

10.1.3

Required

An Oracle AS defined user (not a system user)
that is used to monitor an Oracle AS server.

Example: SERVER]1_LOGIN = janedoe

MAP_KEY_PREFIX

10.1.3

Required

Any unique HTTP instance name.

Example: my j2eeinstancel.systeml.com

NAME

9.04,
10.1.2, 10.1.3

Required

The OC4dJ instance name. Use the dcmct1
listInstances command to display all Oracle
Application Server instances.

This name is used in messages, reports, and
graphs unless ALIAS is set. Set ALIAS to
uniquely identify each server if more than one
OC4dJ/OHS server on a system share the same
name (NAME is the same within a NODE
block).

Example: SERVER] NAME = exampleServer

PASSWORD

10.1.3

Required

The password for the LOGIN. If LOGIN is
configured, a password must be defined.

Example:

SERVER1 PASSWORD = johndoel23

RMID_START_TIME

9.04,
10.1.2,10.1.3

Conditional

Required if rmid
takes longer than
30 seconds to
start.

Default: 30 (seconds)

The amount of time, in seconds, to wait for
rmid to start before timing out.

Example: RMID START TIME = 60

START _CMD 9.04, Conditional A fully qualified system command that is run
10.1.2,10.1.3 |Required if you |When the HPOM Tool Bank “Start Oracle AS”
want to start the |tool is used. This command is run by USER
Oracle which must be set in order for the “Start Oracle
Application AS” tool to work.
Server from the |NOTE: This command must exit. That is, the
HPOM console |Oracle Application Server process must run in
the background or as a service and it must be
protected from its parent process dying.
Example: SERVER1 START CMD =
/sbin/init.d/oracle start
STOP_CMD 9.04, Conditional A fully qualified system command that is run
10.1.2,10.1.3 |Required if you when the HPOM Tool Bank “Stop Oracle AS”
want to stop the |tool is used. This command is run by USER
Oracle which must be configured in order for the “Stop
Application Oracle AS” tool to work.
Server from the |Example: SERVER1 STOP CMD =
HPOM console |/sbin/init.d/oracle stop
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Table 9

Configuration Properties

Required/
Applicable |Conditional/
Property OAS Version|Optional Description
TIMEOUT 9.04, Optional Default: 120 (seconds). The maximum amount
10.1.2, 10.1.3 of time, in seconds, the Oracle AS SPI tries to
connect to the Oracle Application Server. When
the specified time is exceeded, the Oracle AS
SPI sends an alarm to the message browser
indicating that the Oracle Application Server is
unavailable. If metric C002_ServerStatusRep
is being collected, the unavailability of the
server is logged.
If no time limit is desired, set this property to
-1.
TYPE 9.04, Conditional Default: ajp13. Set to ajp13 if this is an OC4dJ
10.1.2,10.1.3 Required if you |S€rver. Set to ohs if this is an OHS
are configuring a |(HTTP_Server) server.
connector Example: SERVER1 TYPE=ajpl3
URL_PATH 10.1.3 Required Required for discovery and collection of
metrics. It is a mandatory property that every
server in the SiteConfig must have.
Example: SERVER2 URL PATH=/opmn://
samplesystem:6005/my2 home
USER 9.04, Conditional The system username for starting and stopping
10.1.2,10.1.3 |Required if you |the Oracle Application Server from the HPOM
want to start and/APplication Bank.
or stop the Oracle|The default is the username under which the
Application HP Operations agent runs.
Server from the |Example: USER = ias admin
HPOM console
VERSION 9.04, Conditional The version number of the Oracle Application
10.1.2, 10.1.3 |Required for Server in the format Major# [Minor#] where:
Oracle Major# - The primary version number (for
Application example, 10.1)
Server version |Minor# - The service pack installed (for
10.1.2,10.1.3 example, 1 for SP1). If Minor# is not specified,

it defaults to 0 (no service pack installed).
Example: SERVER1] VERSION = 10.1 2

The Configuration
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Sample Configurations for the Oracle AS SPI

Example 1: Single Node/Two Servers

This example is for a single node running two servers: an OC4J and HTTP servers. The
properties HOME, JAVA_HOME, MAP_KEY_PREFIX, and VERSION are global defaults
that apply to all servers and nodes.

HOME=C:/OraHome 1

JAVA HOME=C:/OraHome/jdk

MAP KEY PREFIX=

VERSION=10.1 2

NUM SERVERS=2

NODE some node.hp.com

{
SERVER1 NAME=HTTP Server
SERVER1 TYPE=ohs
SERVERZ2 NAME=home
SERVER2 TYPE=ajpl3

Example 2: Multiple Nodes/Repeated Properties

This example shows how you can configure a group of related systems that have numerous

properties in common. Some nodes, however, might have one or two properties that you need

to set differently. You can address these kinds of situations in three steps:

1 Use the Add Group action in the configuration editor to name the group, specify the nodes

in it, and set the configuration properties. For more information, see Add Group on
page 123.

2 Use the Add Node action in the configuration editor to define individual node properties
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). For more information, see Add Node on page 124.

Properties set for a node take precedence over the same properties set for a group. See
Property Precedence on page 118 for the complete order of property precedence.

In the example, the global default properties HOME, JAVA HOME, and MAP KEY PREFIX are
overridden for SERVER4 and SERVERS of the node group “production” and for node
europa.hp.com.

HOME = /opt/oracle/appsrv
JAVA HOME = /opt/oracle/appsrv/jdk
MAP KEY PREFIX = /appsrv.hp.com
VERSION = 10.1 2
GROUP production
{

mercury.hp.com

venus.hp.com

mars.hp.com

jupiter.hp.com
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NODE production

{

}

SERVER1 NAME HTTP Server

SERVER1 TYPE = ohs

SERVER1 ALIAS = HTTP Server+appsrv.hp.com
SERVER2_NAME = OC4J Portal

SERVER2 TYPE = ajpl3

SERVER3 NAME = home

SERVER3 TYPE = ajpl3

SERVER4 NAME = HTTP Server

SERVER4 TYPE = ohs

SERVER4 ALIAS = HTTP Server+infra.hp.com
SERVER4 HOME = /opt/oracle/infra
SERVER4 JAVA HOME = /opt/oracle/infra/jdk
SERVER4 MAP KEY PREFIX = /oasspi/infra.hp.com
SERVERS NAME = OC4J SECURITY

SERVER5 TYPE = ajpl3

SERVERS HOME = /opt/oracle/infra
SERVER5 JAVA HOME = /opt/oracle/infra/jdk
SERVERS MAP KEY PREFIX = /oasspi/infra.hp.com

NODE europa.hp.com

{

SERVER1 NAME 0C4J SECURITY

SERVERL TYPE = ajpl3

SERVER1 HOME /opt/oracle/infra
SERVER1 JAVA HOME = /opt/oracle/infra/jdk
SERVER1 MAP KEY PREFIX = /oasspi/infra.hp.com
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C Tools

The Oracle AS SPI tools include configuration and troubleshooting utilities.
OASSPI Admin tools include:

e Discover or Configure OASSPI
¢ Init Non-Root

e Self-Healing Info

e Start/Stop Monitoring

e Start/Stop Tracing

e Verify

e View Error Log

e View Graphs

The Oracle AS SPI tools include:

e Launch Oracle AS Console

e Start/Stop Oracle AS

e View Oracle AS Logs

e View Oracle AS Status

Important:

To invoke the GUIs related to the Oracle AS SPI, perform the following steps:

1 Install X-windows client software on the machine from which you will launch the HPOM
for UNIX 9.0x server Operator GUI.

2 Start the X-windows client software.
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OASSPI Admin Tools Group

OASSPI Admin tools enable you to configure, control, and troubleshoot the Oracle AS SPI.
The OASSPI Admin tools group includes the following tools:

Discover or Configure OASSPI

Discover or Configure OASSPI tool launches the configuration editor, You can run either the
discovery or configuration using Discover or Configure OASSPI tool.

The tool Discover or Configure OASSPI launches the configuration editor. The tool Discover or
Configure OASSPI allows you to either identify instances of an Oracle Application Server on a
managed node from the HPOM console (on selecting Launch Discover Tool option) or maintain
the Oracle AS SPI configuration by viewing, editing, or setting configuration properties in the
configuration editor (on selecting Launch Configure Tool option).

For complete instructions on how to configure the Oracle AS SPI, see Chapter 3, Configuring
the Oracle AS SPI.

Function

The following functions are performed by the Configure Tool:
e Updates the configuration on the HPOM management server and managed nodes.

e Creates the directories and files required by the Oracle AS SPI on the selected managed
nodes.

e Sets up data sources for reporting and graphing

e Sets up the Oracle Application Server log files and the Oracle AS SPI error log file for
monitoring

The Discover Tool updates the configuration on the HPOM management server and selected
managed nodes.

The HPOM management server maintains the configuration information for all Oracle
Application servers on HP Operations Manager managed nodes. Each managed node
maintains a subset of the configuration information maintained on the management server.
The configuration information of Oracle Application servers on a node is maintained on that
managed node.

When you make changes to the configuration using the configuration editor, the changes are
always saved on the HPOM management server.

If you select a specific HPOM managed node when you launch Discover or Configure OASSPI,
configuration changes affecting Oracle Application Servers running on that node are
automatically saved on the node. If you do not select a managed node, the configuration
changes are not saved on the managed node.

Configuration changes affecting non-selected managed nodes are saved to the configuration
on the HPOM management server and not on the non-selected managed node. To save the
changes on the node, you must select the managed node and re-run the Discover or Configure
OASSPI tool.

To Launch the Discover or Configure OASSPI Tool

1 From the HPOM console, select Integrations - HPOM for Unix Operational Ul.
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2 Select the node(s) on which you want to launch Discover or Configure OASSPI tool.

3 Right-click on the node(s).

4 Select Start > SPI for Oracle AS > OASSPI Admin — Discover or Configure OASSPI.
The Tool Selector window opens.

5 To run the discover tool, select the Launch Discover Tool radio button and click OK. To run
the configure tool, select the Launch Configure Tool radio button and click OK. By default,
the Launch Configure Tool radio button is selected.

6 See Task 4: To Run Discovery on page 39 and Task 8: To Run Configuration on page 44 for
more information on how to launch Discover or Configure OASSPI tool.

Init Non-Root

Updates the /var/opt/OV/bin/instrumentation/wasspi oas platdef.pm file and
generates the wasspi sudoers configuration file on the selected managed nodes.

This tool simplifies the configuration of a non-root HTTPS agent on a UNIX managed node.
For all the steps necessary to configure a non-root HTTPS agent on a UNIX managed node,
see Configuring a Non-Root HTTPS Agent on a UNIX Managed Node on page 45.

Function

The Init Non-Root tool performs the following functions on the selected managed nodes:

1 Runsthe wasspi perl -S wasspi initnonroot -prod oas -force command to set the
proper SPI path.

2 Generates the wasspi perl sufile.

To Launch the Init Non-Root Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start > SPI for OASSPI - SPI Admin — Init Non-Root.
The Init-Non Root Output window opens.

Self-Healing Info

The Self-Healing Info tool collects data that you can send to your HP support representative.

Required Setup

If you are collecting data for a reproducible problem, follow these steps before running the
Self-Healing Info tool:

1 Run the Start Tracing tool. For more information, see Start/Stop Tracing on page 138.

2 Reproduce the problem.

Function

Self-Healing Info tool performs the following functions:
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e Saves data in the following file:
— on a UNIX managed node: /tmp/wasspi oas support.tar

— on a Windows managed node: wasspi oas support.zip in $TEMP$% directory.

) This file might be hidden on some Windows managed nodes. If you do not see the
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click
the View tab. Under Hidden files and folders, select Show hidden files and folders.

e Launches and saves data using the Verify tool (for more information, see Verify on
page 139).

To Launch the Self-Healing Info Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2 Select Start > SPI for OASSPI - SPI Admin — Self-Healing Info.

The Self-Healing Info Output window opens.

Start/Stop Monitoring

When you launch the Start/ Stop Monitoring tool, the Oracle AS SPI starts/stops collecting
metrics for OC4J/OHS server instances on a managed node.

Function
e Start Monitoring starts the collection of metrics for one or all OC4J/OHS servers on a
managed node.

These metrics generate alarms when thresholds are exceeded. You can also use the
metrics to create reports (automatically or manually generated) and graphs. These
reports and graphs are used to analyze trends in server usage, availability and
performance.

e Stop Monitoring stops the collection of metrics for one or all OC4J/OHS servers on a
managed node.

You can stop monitoring on a managed node if the node is not running for a known reason
(for example, the node is down for maintenance). Stopping the monitoring prevents
unnecessary alarms from being generated.

You can launch the Verify tool to check whether the monitoring has started or stopped. By
default, monitoring is on.

To Launch the Start/Stop Monitoring Tool
1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start > SPI for OASSPI - SPI Admin — Start/Stop Monitoring.
The Start/Stop Monitoring Output window opens.

Start/Stop Tracing

Starts/stops saving information about each of the activity performed by the SPI on the
managed node into a file.
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Function

Start Tracing saves information about each of the activity performed by the SPI on the
managed node into a file.

Stop Tracing stops logging the information about each of the activity performed by the SPI on
the managed node into a file.

Run this tool only when instructed by your HP support representative.

Run the Self-Healing Info tool to collect the file(s) created by this tool as part of the data to be
used by your HP support representative.

To Launch the Start/Stop Tracing Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2 Select Start > SPI for OASSPI - SPI Admin — Start/Stop Tracing.

The Start/Stop Tracing Output window opens.

Verify

You can run the Verify tool to check whether the files (instrumentation, configuration, library
files, and so on) required for the functioning of the SPI is properly deployed.

) Before you launch the Verify tool make sure that you installed the latest version of
Self-Healing Service (SHS) component from the SPI DVD.
Function
The Verify tool verifies whether the files (instrumentation, configuration, library files, and so

on) required for the functioning of the Oracle AS SPI is properly deployed on the managed
node and management server.

To Launch the Verify Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start > SPI for OASSPI - SPI Admin —> Verify.
The Verify Output window opens.

View Error Log

You can use the View Error Log tool to view the contents of the Oracle AS SPI error log file.

Function

View Error Log displays the contents of the Oracle AS SPI error log file <OV_AGT DIR>/
wasspi/oas/log/wasspi perl.log.

In this instance, <OV_AGT_ DIR> typically is:

e /var/opt/0V on UNIX managed nodes

139



140

® \Documents and Settings\All Users\Application Data\HP\HP BTO
Software\ on Windows managed nodes

To View the Oracle AS SPI Error Log

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start > SPI for OASSPI - SPI Admin — View Error Log.

The View Error Log Output window opens.

View Graphs

You can use the View Graphs tool to view HP Performance Manager graphs in a web browser.

Required Setup

HP Performance Manager must be installed and you must configure Mozilla or Netscape
browser on the HP Operations Manager for UNIX before this tool can run successfully.

If you are using Netscape Navigator, use version 6.0 or higher.
Function

The View Graphs tool launches a web browser to display, as graphs, the Oracle AS SPI metric
data. These graphs are generated using HP Performance Manager.

To Launch the View Graphs Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2 Select Start > SPI for OASSPI - SPI Admin — View Graphs.

The View Graphs Output window opens.
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Oracle AS SPI Tools Group

The tools in the Oracle AS SPI group provide you access to the functions of Oracle Application
Server from the HPOM console. The Oracle AS SPI tools group includes the following tools:

Launch Oracle AS Console

By running the Launch Oracle AS Console tool you can bring up the Oracle Application
Server Control Console.

Required Setup

¢ Configure Mozilla or Netscape browser on the HP Operations Manager for UNIX before
launching this tool.

e Install Oracle AS Enterprise Manager on the managed node to launch the Oracle
Enterprise Manager Database Control.

Function

Launch Oracle AS Console brings up the Oracle Application Server Admin Console in a web
browser for a single application server or all application servers on the selected node.

To Launch the Launch Oracle AS Console Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start - SPI for OASSPI - Oracle AS SPI = Launch Oracle AS Console.

The Launch Oracle AS Console Output window opens.
3 Select an option:

— 1 - Launch the Oracle Application Server Control Console

— 2 - Launch AggreSPY

— 3 - Launch the Oracle Enterprise Manager Database Control (Oracle AS Enterprise
Manager must be installed on the managed node for this option to be available)

— q - Quit the tool

Start/Stop Oracle AS

You can start or stop one or more instances of Oracle Application Servers from the HP
Operations Manager (HPOM) console by running the Start Oracle AS tool, without logging in
to each individual Oracle Application Server Control Consoles.

Required Setup

The START_CMD, STOP_CMD, and USER configuration properties must be set before this
tool can run successfully.
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Function

Start or Stop Oracle AS tool starts or stops one or all application servers on the selected
managed nodes.

To Launch the Start/Stop Oracle AS Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2 Select Start - SPI for OASSPI - Oracle AS SPI — Start/Stop Oracle AS.
The Start/Stop Oracle AS Output window opens.

View Oracle AS Logs

You can use View Oracle AS Logs tool enables you to view Oracle Application Server log files
without logging in to the system on which the Oracle Application Server is running.

Function

View OAS Logs tool performs the following functions:

e Ifyou launch View Oracle AS Logs without a parameter, the tool displays a numbered list
of available log files for the selected managed node.

¢ If you launch View Oracle AS Logs with an invalid parameter (a non numeric value or a
number that does not correspond to the list of available log files), the tool displays a
numbered list of available log files for the selected managed node.

e Ifyou launch View Oracle AS Logs with an valid parameter, the tool displays the contents
of the corresponding log file for the selected managed node.

You can enter only one numeric value in the parameter field and view the log file
corresponding to that number. Select one log file to view per managed node every time you
launch the View OAS Logs tool.

If you keep the Tool Status window open and relaunch the tool, the output in the Tool Status
window accumulates.

To Launch the View Oracle AS Logs Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2 Select Start > SPI for OASSPI - Oracle AS SPI - View Oracle AS Logs.
The View Oracle AS Logs Output window opens.

View Oracle AS Status

The View Oracle AS Status tool displays a status report of the Oracle Application Servers
running on a selected managed node. You can use this tool to check the status of each
application server running on the node.
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Function

View Oracle AS Status displays the Oracle Application Server instance name, hostname,
Oracle home, and processes (component, type, process ID, and status) for each application
server instance.

To Launch the View Oracle AS Status Tool

1 Follow the steps step 1 to step 3 in Discover or Configure OASSPI on page 136.
2  Select Start > SPI for OASSPI - Oracle AS SPI = View Oracle AS Status.

The View Oracle AS Status Output window opens.
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Glossary

agent

A program or process running on a remote device or computer system that responds to
management requests, performs management operations, or sends performance and event
notification. An agent can provide access to managed objects and MIB variables, interpret
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is run in response to an event, message, or a change
in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service
from another computer (server). When the context is software, a program or executable
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out.
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that
make up the network. For example the components of a network can include computer
systems, routers, switches, hubs, operating systems and network software. The configuration
of the network determines the way that it works and the way that it is used. In a software
context, the combination of settings of software parameters and attributes that determine the
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified
environment, application or usage.

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of
applications.

customization

The process of designing, constructing or modifying software to meet the needs and
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the
business environment.

Deployed application

An application and its components that are installed and started to work in the business
environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.



event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated
by an agent or process in a managed object or by a user action. Events usually indicate a
change in the state of a managed object or cause an action to occur.

HP Operations Manager

A family of network and system management products, and an architecture for those
products. HP Operations Manager includes development environments and a wide variety of
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure.

icon

An on-screen image that represents objects that can be monitored or manipulated by the user
or actions that can be started by the user.

managed object

A network, system, software or service object that is both monitored for performance, status
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application
or set of management applications. The console might be on the system that contains the
management software or it might be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of
one or more events relative to specified conditions, or a change in application, system,
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an
event, the evaluation of one or more events relative to specified conditions or a change in
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from
particular events.The string summarizes the important characteristics of the event. Message
keys can be used to allow messages to acknowledge other messages, and allows for the
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that
initiated the message. See also severity level.

metadata
Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT
environments. Management products are added or "snapped into" the management console
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the
presentation of a specific type of data. Modules can interact with one another and with other
software.

node

When the context is network, a computer system or device (for example, printer, router,
bridge) in a network. When the context is a graphical point to point layout, a graphical
element in a drawing that acts as a junction or connection point for other graphical elements.

parameter

A variable or attribute that might be given an arbitrary value for use during an execution of
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data
that is valid for the parameter. For example a parameter type could be IP Address which
indicates that parameter values must have 4 numbers separated by decimals with the value
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policies

A set of one or more specifications rules and other information that help automate network,
system, service, and process management. Policies can be deployed to various targets (for



example, managed systems, devices, network interfaces) providing consistent, automated
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying,
deleting) for the purposes of network, system or service management.

policy type
An abstraction or categorization of policies based on the function of the policy or the services
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device.
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for
example, management capabilities, file storage capabilities) to other computer systems
(clients) on the network. If the context is a software component, a program or executable
process that responds to and services requests issued by clients.

severity level
A property of an object indicating the status of the object. Severity level is based on the impact
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management
capabilities specific to a given type of business application, database, operating system, or
service.

trace log

An output file containing records of the execution of application software
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A

actions
automatic, 51
customizing, 51
operator-initiated, 51

adding
nodes to OAS SPI node group, 38

Add Node action, 121, 123
Add OC4J/OHS Server action, 121, 122

alarms
modifying, 51

Application Servers tree item, 120
assigning operator responsibilities, 35
automatic action reports, 60
automatic actions, 51

automatically generated reports, 60

C
Cancel button, 121

CODA
using, 65

collection intervals
changing, 55
changing for selected metrics, 56

collector
wasspi_ca command, 53

collector policies, 21
components, 15

conditional properties
configuring, 45
setting, 45

configuration
properties, 127
structure, 117
syntax, 117

configuration editor
See Configure OASSPI application

configuration example
group and node properties, 132
single node/two servers, 132

Configuration tree item, 120

configuring

management server, 38

prerequisites, 35
customization, 12
customizing

actions, 51

duration, 50

message text, 50

severity, 50
thresholds, 50

D

Default Properties tree item, 120
Defaults tree item, 120

Deploy UDM tool, 20
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Discover or Configure OASSPI tool, 17, 39, 136
actions, 121
Add Group action, 121, 123
Add Node action, 121, 123
Add OC4J/OHS Server action, 121, 122
Application Servers tree item, 120
buttons, 121
Cancel button, 121
Configuration tree item, 120
Default Properties tree item, 120
Defaults tree item, 120
Exit action, 122
Finish button, 121
Groups tree item, 120
how to run, 136
icons, 119
Next button, 121
Nodes tree item, 120
Remove ALL Groups, 122, 124
Remove ALL Nodes action, 125
Remove ALL OC4J/OHS Servers action, 122,
124
Remove Group action, 122, 124
Remove Node action, 122, 125
Remove OC4J/OHS Server action, 122, 124
Save action, 122
Save button, 121
Set Configuration Properties tab, 122, 125
tree, 119
using, 119
View Configuration Settings tab, 122, 126
what it does, 136

Discover tool
setting LOGIN and PASSWORD, 39

discovery process
verifying, 42

distributing
policies, 43

duration
customizing, 50

E

editing
alarms, 51
policies, 49

error messages, 89 to 114
Exit action, 122

F

files, locations on management server/managed
nodes, 82

Finish button, 121
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G

Gather MBean Data tool, 20
global properties, 117
GRAPH_URL property, 129

graphs
date range, 72
example, 68
generating, 72
HP Performance Manager, 65
metrics used to generate, 70
operator action, 72
viewing alarm conditions, 70
viewing conditions, 70

GROUP block, 117
Groups tree item, 120

H

HOME_LIST property, 129
HOME property, 129

HP Performance Agent, 65

HP Performance Manager
integrating with OAS SPI, 68

Init Non-Root tool, 17, 137
how to run, 137
what it does, 137

installing, 26
OAS SPI report package, 66
swinstall, 27

instruction text
location, 13

J

JAVA_HOME property, 129
OASSPI-Metrics, 21
OASSPI-Monitors, 22

JMX Metric Builder tool, 20
JMX Metric Builder Tools, 20

L

Launch Oracle AS Console tool, 18, 141
how to run, 141

Launch OracleAS Console tool
required setup, 141
what it does, 141

license count, 63



logfiles policies, 21

LOGIN
setting, 39

M

managed nodes

adding to OAS SPI node group, 38

management server
configuring, 38

manually generated reports, 60
message policy, 22

messages
instruction text, 13
message browser, 12

message text
customizing, 50

metrics
data collected, 11
graphs generated from, 70
reports generated from, 66

metrics policies, 21

modifying
alarms, 51
policies, 49

monitor policies, 21

N

NAME property, 130
Next button, 121
NODE block, 118
Nodes tree item, 120

O
OAS SPI

components, 15
overview, 12

OASSPI Admin tool group, 16
OASSPI Discovery, 22
OASSPI-Logfiles policy group, 21
OASSPI-Messages, 22
OASSPI-Messages policy, 22
OASSPI-Metrics policy group, 21
OASSPI-monitor group, 21
OASSPI-Monitors, 21

OAS SPI node group
adding nodes, 38

OASSPI Policy Group, 21
OASSPI Reports (JMX) Group, 19
OASSPI Reports tool group, 18
OASSPI Service Discovery, 22

operator

assigning responsibilities, 35

operator-initiated actions, 51
Oracle AS SPI discovery policies, 39
Oracle AS tool group, 18

P

PASSWORD

setting, 39

policies, 20

collector, 21
customizing, 49
distributing, 43
logfiles, 21

message, 22

metrics, 21
modifying, 49
monitor, 21
OASSPI-Messages, 22
reinstalling, 59

policy groups, 20

changing collection intervals, 56
customizing, 57
OASSPI-Logfiles, 21
OASSPI-Metrics, 21
OASSPI-Monitor, 21

prerequisites

configuring, 35

properties, 127

R

configuring conditional, 45
definitions, 129 to 131
global, 117

precedence, 118
server-specific, 118
setting conditional, 45

reinstalling

policies, 59

Remove ALL Groups action, 122, 124
Remove All Nodes action, 122, 125
Remove ALL OC4J/OHS Servers action, 122, 124
Remove Group action, 122, 124
Remove Node action, 122, 125
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Remove OC4J/OHS Server action, 122, 124

removing
OAS SPI, 32

Reporter
integrating with OAS SPI, 66

Reporter reports, 66

Report package, 14

report package
installing, 33, 66

reports
automatic action, 60
automatically generated, 60
included, 14
manually generated, 60
metrics used to generate, 66
Reporter, 65, 66
tool bank, 60
tool bank generated, 59
viewing, 60

reports (automatic action)
how they are generated, 59

RMID_START_TIME property, 130

S
Save action, 122
Save button, 121

Self-Healing Info tool, 17, 137
how to run, 138
required setup, 137
what it does, 137

server-specific properties, 118

service map, 39

Set Access Info for Default Properties window, 40
Set Configuration Properties tab, 122, 125

Set Configuration Settings tab
modifying a property, 125
removing a property, 126
setting a property, 125

setting
conditional properties, 45

severity
customizing, 50

START_CMD property, 130

Start Monitoring tool, 17, 138
how to run, 138
what it does, 138

Start Oracle AS tool, 18, 141
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Start OracleAS tool
required setup, 141
what it does, 142

Start Oracle AS tool how to run, 142
Start Tracing tool, 17, 138
how to run, 139
what it does, 139
STOP_CMD property, 130
Stop Monitoring tool, 17, 138

how to run, 138
what it does, 138

Stop Oracle AS tool, 18, 141
how to run, 142

Stop OracleAS tool
required setup, 141
what it does, 142

Stop Tracing tool, 17, 138
how to run, 139
what it does, 139

structure
configuration, 117

swinstall, 27
reinstalling policies, 59

syntax
configuration, 117

T
t, 17
tag option
creating custom policy groups, 57

thresholds
customizing, 50
settings for different servers, 57

TIMEOUT property, 131

tool bank
reports, 60



tools, 15, 135
Deploy UDM, 20
Discover or Configure OASSPI, 17, 39, 136
Gather MBean Data, 20
Init Non-Root, 17, 137
JMX Metric Builder, 20
Launch Oracle AS Console, 18, 141
OASSPI Admin group, 16
OASSPI Reports group, 18
Oracle AS group, 18
Self-Healing Info, 17, 137
Start Monitoring, 17, 138
Start Oracle AS, 18, 141
Start Tracing, 17, 138
Stop Monitoring, 17, 138
Stop Oracle AS, 18, 141
Stop Tracing, 17, 138
UDM Graph Disable, 20
UDM Graph Enable, 20
Verify, 17, 139
View Error Log, 17, 139
View Graphs, 17, 140
View OAS Logs, 18, 142
View Status, 18, 142

TYPE property, 131

U
UDM Graph Disable tool, 20
UDM Graph Enable tool, 20
upgrading, 28

OAS SPI report package, 33
user defined metrics

graphing, 79
USER property, 131

using
Discover and Configure OASSPI tool, 119

\'}

verifying
discovery process, 42
Verify tool, 17, 139
how to run, 139
what it does, 139

VERSION property, 131

View Configuration Settings tab, 122, 126
View Inherited Properties, 127

View Error Log tool, 17, 139
how to run, 140
what it does, 139

View Graphs tool, 17, 140
how to run, 140
required setup, 140
what it does, 140

viewing
reports, 60

View Inherited Properties, 127
View OAS Logs tool, 18, 142

how to run, 142
what it does, 142

View Status tool, 18, 142
how to run, 143
what it does, 143

w

wasspi_ca command, 53

wasspi_oas_ca command
parameters, 53
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